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Glossary Terms

Below is the list of glossary terms used in CorelPHOTO-PAINT. To read a definition, point to 
the word you want and press the left mouse button.

active picture 
window
background color
backup copy
cascading menu
check box
click
clipboard
color selection box
command button
CONFIG.SYS
constrain
Control menu
control points
cutout
defined area
double-click
dpi
drag
drop-down list
filters
gradient
gray scale
grouped tools
halftone pattern
handles
icon
list box

maximize
menu bar
mini-scroll bar
minimize
option button
Palette
picas
picture window
pixels
points
press
primary color
printer halftone
retouch tools
Screen Preview
secondary color
temporary files
text box
tile pattern
title bar
Toolbox
virtual memory
Width & Shape 
workbox
Windows 3.0
work area



Welcome to CorelPHOTO-PAINT

CorelPHOTO-PAINT combines an excellent collection of painting tools, plus powerful 
retouching capabilities, all in one easy to use Windows application. 
The combinations are endless. Device independence allows for true color editing of up to 
16.7 million colors. Choose from a wide variety of painting and image processing features to 
create new images or enhance scanned pictures. 
Once you have the perfect picture, you can use it in any major draw, presentation, page 
layout, and word processing program. 
· See the Index for a quick glance of available Help information.
· See your CorelPHOTO-PAINT manuals for more complete information.
· You may want to read For Beginners if you are a newcomer.



The File Menu

You use File menu commands to start new pictures, load and save pictures clear a picture to 
the background color, print pictures, select your printer and change printer options, and exit 
CorelPHOTO-PAINT.
The File menu picture list displays the last four pictures you opened. As you open pictures, 
their names are added to the list. Click a picture name to open it.
To choose a File menu command, click File and choose the command. Some commands are 
on cascading menus.

File Menu Commands
New Creates a new picture.
Open Loads a picture previously saved to disk or stored on the clipboard.
Close Closes the picture and all its duplicates.
Save Saves changes you make to a picture previously saved to disk.
Save As Saves a new picture for the first time or saves a picture previously saved to 

disk with a new name or in a new format.
Clear Replaces the current image with the selected background color.
Print Prints the picture.
Printer Setup Selects the printer and printer options you use to print.
Exit Closes the CorelPHOTO-PAINT program.



File New Command -- Starting a New Picture

To start a new picture:
1.Select a Units option.
2.Select a color format from the Mode drop-down list.
3. Select a size for your picture in the Width and Height boxes.
4. Choose OK.

Related Topics
Open
Working with Different Numbers of Colors



File Open Command -- Opening an Existing Picture

To open a previously saved picture:
1.Select a File Type option.
2. Select the drive and directory you want.
3. Click a file in the File Name list box.
4. Choose OK.

Related Topics
Duplicate
New
Previewing a Picture
Working with Different Numbers of Colors



Previewing a Picture

To preview a picture:
1.Read the displayed information.
2. Click Show Thumbnail to see a small representation of the picture.
3. Choose OK to return to the dialog box.

Related Topics
Open
Paste From
Preferences
Tile Pattern
Working with Different Numbers of Colors



File Close Command -- Closing a Picture

To close a picture and all its duplicates:
1.Choose Close from the File menu.
2. If you have made changes since the last time you saved, CorelPHOTO-PAINT asks if you 

want to save them.

Related Topics
Control Menu
Duplicate
Exiting CorelPHOTO-PAINT
Save As
Saving a Picture with Save



File Save Command -- Saving a Picture with Save

To resave a previously saved picture:
· Choose Save from the File menu.

Related Topics
Save As



File Save As Command -- Saving a Picture with a New Name

To save a picture for the first time or to resave an existing picture:
1.Select a File Type option.
2. Select other available options from the File Sub-Format drop-down list.
3. Select where you want to save the file.
4. Type a name for the file.
5. Choose OK.

Related Topics
Saving a Picture with Save



File Clear Command -- Clearing Your Picture to the Background Color

To clear your picture to a new background color:
1.Select a background color.
2.Choose Clear from the File menu.

Related Topics
Color Replacer
Eraser



File Print Command -- Printing a Picture

To print a picture:
1.Select a size for the printed picture.
2. Select a halftone option.
3. Choose OK.

Related Topics
Printer Setup



File Printer Setup Command -- Setting Up Your Printer

To set up your printer:
1.Select a printer from the Printer list box.
2.Click Setup to change some of the printer options.
3. Choose OK.

Related Topics
Print



File Exit Command -- Exiting CorelPHOTO-PAINT

To end your CorelPHOTO-PAINT session:
1.Choose Exit from the File menu.
2. If you have made changes to a picture since the last time you saved, CorelPHOTO-PAINT 

asks if you want to save them.

Related Topics
Closing a Picture



The Edit Menu

You use Edit menu commands to change the color format of pictures, apply filters, correct 
mistakes, copy or cut to the clipboard or to disk, paste from the clipboard or disk, and flip, 
rotate, invert and outline pictures or cutouts.
To choose an Edit menu command, click Edit and choose the command. Some commands 
are on cascading menus.

Edit Menu Commands
Undo Cancels changes made since the last time you chose a tool or 

command.
Cut Deletes a defined area and copies it to the clipboard.
Copy Copies of the picture to the clipboard.
Paste Places the contents of the clipboard, surrounded by the marquee, in 

the upper left corner of the picture.
Delete Deletes a defined area without copying it to the clipboard.
Copy To Copies a defined area to disk.
Paste From Places a picture saved to disk, surrounded by the marquee, in the 

upper left corner of the picture.
Convert To Converts pictures to another color mode.
Filter Add Noise Creates a textured effect in pictures or cutouts.
Filter Blend Smooths pictures or cutouts.
Filter Brightness Adjusts brightness and
    and Contrast contrast in pictures or cutouts.
Filter Color/ Adjusts gray and color
    Gray Map inaccuracies in pictures or cutouts.
Filter Diffuse Scatters colors in pictures or cutouts.
Filter Edge Detect Enhances edges in pictures or cutouts.
Filter Emboss Embosses pictures or cutouts.
Filter Equalize Redistributes the shades of colors in pictures or cutouts.
Filter Pixelate Creates a blocklike effect in pictures or cutouts.
Filter Motion Blur Adds a blur effect in pictures or cutouts.
Filter Remove Spots Erases spots and blotches in pictures or cutouts.
Filter Sharpen Enhances detail in pictures or cutouts.
Transform Flip Flips pictures or cutouts
    Horizontal horizontally.
Transform Flip Flips pictures or cutouts
    Vertical vertically.
Transform Invert Reverses colors in pictures or cutouts.
Transform Outline Outlines shapes in pictures or cutouts.
Transform Rotate 90°Rotates pictures or cutouts clockwise.
Transform Area Flips, rotates, deskews, or resizes pictures or cutouts.

Related Topics
Using Filters



Edit Undo Command -- Undoing Changes to Your Picture

To cancel recent changes:
· Choose Undo from the Edit menu.

Related Topics
Cutting to the Clipboard
Deleting Portions of Your Picture
Eraser
Local Undo



Edit Cut Command -- Cutting to the Clipboard

To cut a defined area to the clipboard:
1.Select a background color to fill the cut area.
2.Define an area.
3. Choose Cut from the Edit menu.

Related Topics
Box Selection
Copying to the Clipboard
Deleting Portions of Your Picture
Eraser
Lasso
Magic Wand
Pasting from the Clipboard
Scissors
Undoing Changes to Your Picture



Edit Copy Command -- Copying to the Clipboard

To copy a defined area to the clipboard:
1.Define an area.
2. Choose Copy from the Edit menu.

Related Topics
Copy To
Cut
Pasting from the Clipboard



Edit Paste Command -- Pasting from the Clipboard

To paste a cutout from the clipboard:
1.Choose Paste from the Edit menu.
2. Drag the cutout to move it to another area.
3. Choose a tool or click outside the Gadget Box to paste the cutout.

Related Topics
Convert To
Copying to the Clipboard
Cutting to the Clipboard
Palette Open Palette
Paste From



Edit Delete Command -- Deleting Portions of Your Picture

To delete a defined area from your picture:
1.Select a background color to fill the cut area.
2.Define an area.
3. Choose Delete from the Edit menu.

Related Topics
Cutting to the Clipboard
Eraser
Undoing Changes to Your Picture



Edit Copy To Command -- Saving Portions of Your Picture to Disk

To copy a defined area to a file:
1.Select a File Type option.
2. Select other available options from the File Sub-Format drop-down list.
3. Select where you want to save the file.
4. Type a name for the file.
5. Choose OK.

Related Topics
Copying to the Clipboard
Cutting to the Clipboard
Paste From
Pasting from the Clipboard



Edit Paste From Command -- Pasting from Disk

To paste an image from a file:
1.Select a File Type option.
2. Select the drive and directory you want.
3. Click a file in the File Name list box.
4. Choose OK.
5. Drag the cutout to move it to another area.
6. Choose a tool or click outside the Gadget Box to paste the cutout.

Related Topics
Convert To
Copy To
Palette Open Palette
Pasting from the Clipboard
Previewing a Picture



Using Filters

You use filters to enhance images and create special effects in pictures or cutouts. 
Filters are only one aspect of image enhancement. CorelPHOTO-PAINT also has tools and 
other commands you can use to edit your pictures.
Keep the following in mind when using filters:
· All filters are available with Gray Scale or 24 Bit Color pictures. Brightness and Contrast, 

Equalize, Posterize, Remove Spots, and Response Curve are available with 256 Color 
pictures. Remove Spots is the only filter available with Black and White pictures.

· Filters work best when your picture is 24 Bit Color or Gray Scale. You can convert your 
picture to one of these color modes.

· Filters work fastest with a Gray Scale picture. Filters require more time with a 256 Color 
picture than a 24 Bit Color picture.

· If you change default filter settings, they are saved when you end your current 
CorelPHOTO-PAINT session.

· If you need to return to CorelPHOTO-PAINT default settings, you can delete your 
CORELPNT.INI file. Note that all of your program settings will return to program defaults, 
including any soft brush settings you have specified.

· Screen Preview allows you to view changes to your picture before they are made.
· Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-by-

pixel.
· Undo cancels everything you've done since the last time you chose a tool or command.

Related Topics
Filter Add Noise
Filter Blend
Filter Brightness and Contrast
Filter Color/Gray Map
Filter Diffuse
Filter Edge Detect
Filter Emboss
Filter Equalize
Filter Posterize
Filter Motion Blur
Filter Remove Spots
Filter Sharpen
Working with Different Numbers of Colors



Edit Filter Add Noise Command -- Adding Texture to Your Picture

To add texture to pictures or defined areas:
1.Use the Variance mini-scroll bar to specify the amount of texture you want.
2. Choose Flat or Bell Curve from the Distribution drop-down list.
3. Choose the color channel you want to affect.
4. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Blend Command -- Blending with the Blend Filter

To blend pictures or defined areas:
1 .Use the Blending Amount mini-scroll bar to specify the amount of blending you want.
2. Select Wide Aperture to create a smoother effect.
3. Choose OK.

Related Topics
Blend Paintbrush
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Brightness and Contrast Command -- Adjusting Brightness and 
Contrast

To change brightness or contrast in pictures or defined areas:
1.Type the amount of Brightness and Contrast you want.
2. Choose OK.

Related Topics
Box Selection
Brighten Paintbrush
Contrast Paintbrush
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Diffuse Command -- Diffusing Your Picture

To scatter colors in pictures or defined areas:
1 .Use the Height and Width mini-scroll bars to specify the amount of diffusion you want.
2. Click Allow Color Shift if it is available to introduce new colors in the picture.
3. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Edge Detect Command -- Enhancing Edges

To enhance edges in pictures or defined areas:
1.Use the Sensitivity mini-scroll bar to specify what types of edges to select.
2. Choose the color you want for the non-outlined areas from the Color drop-down list.
3. Choose a style for the color of the outline from the Edge drop-down list.
4. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Transform Outline
Using Filters



Edit Filter Emboss Command -- Embossing Your Picture

To emboss pictures or defined areas:
1.Click a Direction button.
2. Select a color from the Emboss Color drop-down list.
3. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Equalize Command -- Changing Your Highlights and Shadows

To equalize pictures or defined areas:
1.Drag the arrows at the bottom of the bar graph to adjust the Low, Mid, and High values.
2. Choose OK.

Related Topics
Box Selection
Convert To
Filter Color/Gray Map
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Posterize Command -- Pixelating Your Picture

To create blocklike effects in pictures or defined areas:
1.Use the Width and Height mini-scroll bars to specify the blockiness of the effect.
2. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Motion Blur Command -- Creating a Motion Effect in Your Picture

To add a motion effect to pictures or defined areas:
1.Click a Direction button.
2. Use the Speed mini-scroll bar to specify the amount of blurring.
3. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Remove Spots Command -- Cleaning Up an Image

To remove unwanted spots in pictures or defined areas:
1.Choose the spot size to remove.
2. Choose OK.

Related Topics
Box Selection
Convert To
Eraser
Lasso
Magic Wand
Scissors
Using Filters



Edit Filter Color/Gray Map Command -- Fine-Tuning with the Color/Gray Map Filter

To apply the Color/Gray Map filter:
1.Select a Preset option, and CorelPHOTO-PAINT automatically adjusts your picture.
2.Select colors to change from the Channel drop-down list.
3. Select a Style to make other changes.
4. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Loading Response Curve Settings
Magic Wand
Saving Response Curve Settings
Scissors
Using Filters



Filter Color/Gray Map Style Options

· You can use several styles to get the response curve you want.
· You can also load Response Curve settings you have previously saved to disk.

Curve
Freehand
Linear

· This picture illustrates the color values represented in the response curve sample box:

Related Topic
Filter Color/Gray Map



Loading Response Curve Settings

To load Response Curve settings:
1.Select the drive and directory you want.
2. Click a file in the File Name list box.
3. Choose OK.

Related Topics
Filter Color/Gray Map
Saving Response Curve Settings



Saving Response Curve Settings

To save response curve settings:
1.Choose Filter Color/Gray Map.
2.Adjust the settings.
3.Choose OK.
4. Reselect the Filter Color/Gray Map command.
5. Click Save.
6. Select where you want to save the file.
7. Type a name for the file.
8. Choose OK.

Related Topic
Loading Response Curve Settings



Edit Filter Sharpen Command -- Sharpening with the Sharpen Filter

To sharpen pictures or defined areas:
1.Use the Sharpen mini-scroll bar to specify the amount of sharpening.
2. Select Wide Aperture for greater sharpening.
3. Choose OK.

Related Topics
Box Selection
Convert To
Lasso
Magic Wand
Scissors
Sharpen Paintbrush
Using Filters



Edit Convert To Command -- Changing Color Formats

To convert a picture to another color format:
1.Choose Convert To from the Edit menu.
2.Choose the option you want.

Related Topics
Save As
Working with Different Numbers of Colors



Convert To Dialog Box Options
Black and White
256 Color
24 Bit Color
Gray Scale



Edit Transform Flip Horizontal Command -- Making a Mirror Image

To flip pictures or defined areas horizontally:
· Choose Transform Flip Horizontal from the Edit menu to make a mirror image.

Related Topics
Box Selection
Lasso
Magic Wand
Scissors
Transform Area
Transform Flip Vertical



Edit Transform Flip Vertical Command -- Turning Your Picture Upside Down

To flip pictures or defined areas vertically:
· Choose Transform Flip Vertical from the Edit menu to turn your picture upside down.

Related Topics
Box Selection
Lasso
Magic Wand
Scissors
Transform Area
Transform Flip Horizontal



Edit Transform Invert Command -- Inverting Colors in Your Picture

To invert the colors in pictures or defined areas:
· Choose Transform Invert from the Edit menu.

Related Topics
Box Selection
Color Replacer
Lasso
Magic Wand
Scissors



Edit Transform Outline Command -- Outlining Shapes in Your Picture

To outline shapes in pictures or defined areas:
1.Select a background color.
2.Choose Transform Outline from the Edit menu.

Related Topics
Box Selection
Filter Edge Detect
Lasso
Magic Wand
Scissors



Edit Transform Rotate 90° -- Turning Your Picture on Its Side

To rotate pictures or defined areas 90°:
· Choose Transform Rotate 90° from the Edit menu.

Related Topics
Box Selection
Lasso
Magic Wand
Scissors
Transform Area



Edit Transform Area Command -- Flipping, Rotating, and Resizing

To flip, rotate, deskew, or resize pictures or defined areas:
1.Choose the options you want.
2. Choose OK.

Related Topics
Box Selection
Lasso
Magic Wand
Manipulating Defined Areas
Scissors
Transform Flip Horizontal
Transform Flip Vertical
Transform Rotate 90°



Transform Area Dialog Box Options
Flip Horizontal
Flip Vertical
Rotate
Width and Height
Proportional Resize
Units

Related Topics
Transform Area



The Font Menu

You use Font menu commands to select fonts and to choose a different loaded font.
To choose a command from the Font menu, click Font and choose the command you want.
To change your font, you can click the Font menu and choose another font from the list. For 
more information see Changing Your Font.

Font Menu Commands
Select Allows you to open fonts.



Changing Your Font

To select a listed font:
1.Click the Font menu.
2.Select a listed font.

Related Topics
Select
Text



Font Select Command -- Selecting Fonts

To open a font:
1.Select the font you want to open and style from the Font list.
2. Select a Font Style option.
3. Select a Size option.
4. Select an Effects option.
5. Choose OK.

Related Topics
Changing Your Font
Text



active picture window
The picture window you are working on. Its title bar is shaded differently from other open 
windows. To make a window active, click its title bar or choose another picture from the 
Window menu.



background color
Many tools and commands use the background color. To change your background color, 
point in the Palette to the color you want, hold down Shift and click the left mouse button. 
You can also select the Eyedropper tool, point to a color in your picture, hold down Shift, and 
click the left mouse button. The new background color appears in the color selection box on 
the left of the Palette. Double-click the Eraser or use Clear to clear a picture window to the 
background color.



backup copy
Choose the Keep Backup Copy option when you use the Save As or Copy To command to 
keep a backup of your picture as it was when you last chose Save or Save As. The backup 
file's name is the same as the original's, except the last letter of the extension is a $. For 
example, the backup file of GRAPH.PCX is GRAPH.PC$.



cascading menu
A command with an arrow to the right of it contains a cascading menu. To choose a 
command on a cascading menu, click a command with an arrow. When the cascading menu 
appears, choose a command.



check box
Found in dialog boxes. Click a box to select it. A selected check box contains an X. Click the 
box again to unselect it. Unavailable choices are dimmed.



click
Point to the area or tool you want, press the mouse button and release it in one smooth, 
quick motion. Unless otherwise noted, click the left mouse button.



clipboard
The clipboard stores graphics or text you cut or copy until you cut or copy again. Use Paste 
to insert graphics from the clipboard into your active picture. To insert text from the 
clipboard, select the Text tool. When the Enter Text dialog box appears, press Shift+Ins.



color selection box 

The box on the left of the Palette that displays current primary, secondary, and background 
colors, tool settings, gradient effect, or the loaded tile pattern. Only the color selection box 
shows in a folded Palette.



command button 
A button in a dialog box that initiates action. For example, OK applies your settings and Help 
activates the help program. Command buttons followed by an ellipsis (...) bring up other 
related dialog boxes.



CONFIG.SYS
The CONFIG.SYS file tells your computer what types of devices are installed in your 
computer system. The CONFIG.SYS file must be in the root directory of your boot disk or 
hard drive.



constrain
Use the Shift key with many tools to force the tool to paint in a particular direction or shape. 
You can constrain the box tools, including the Box Selection tool, to a square. You can 
constrain the Ellipse/Circle tools to a circle. You can constrain other tools vertically, 
horizontally, or at a 45-degree angle. Press the spacebar to change between vertical and 
horizontal constraint.



Control menu 
Click on the box containing a hyphen or dash on the left side of a window's title bar to open 
its Control menu. To open the Control menu of a minimized window, click on the icon. To 
quickly close or hide a window or workbox, double-click the Control menu box.



control points
Squares or circles on the Gadget Box, text frame box, and curve which you use to 
manipulate an area of your picture, the margins of text, or the shape of a curve.



cutout
An area of a picture defined with the Scissors, Box Selection, Lasso, or Magic Wand. A cutout
is surrounded by the Gadget Box and marquee. Use Edit menu commands to cut, copy, 
paste, flip, resize, and apply filters to cutouts. Use the handles on the Gadget Box to 
manipulate a cutout.



defined area
A defined area is a part of a picture that is surrounded by the Gadget Box and marquee. Use 
the Scissors, Box Selection, Lasso, or Magic Wand to define an area. Areas you paste or 
paste from another picture are also defined areas.



double-click
Point to the area or tool you want, quickly press the mouse button twice and release it. 
Unless otherwise noted, double-click the left mouse button.



dpi
Dots per inch. Printers produce a designated ratio of dots per inch. A higher dpi produces a 
sharper image that appears larger on screen and requires more storage space.



drag
Press the mouse button, and hold it down while you move or drag the mouse. Unless 
otherwise noted, press the left mouse button.



drop-down list
List that drops down from a display box to show the current selection. To open a list, click the
underlined arrow. Use the scroll bar to move up and down in the list.



filters
Generally used to improve the look of pictures or create special effects. You can choose a 
filter from the Edit menu and apply it to a cutout or an entire picture.



gradient
Gradients can be vertical, horizontal, or radial. They are shaded from secondary to 
background color. You can create gradient boxes and fonts, and fill an area with a gradient. 
Use Gradient Type to change the look and brightness of a gradient.



gray scale
Solid colors of gray. CorelPHOTO-PAINT supports 256 gray scale pictures. Keep in mind since 
CorelPHOTO-PAINT has device independence, grays that appear halftoned on-screen, retain 
their true colors.



grouped tools    

Similar tools that are grouped together to reduce the size of the Toolbox. A triangle appears 
in the bottom right corner of the displayed tool. To select another tool within a group, press 
the triangle. When the available tools appear, drag to the tool you want, and release the 
mouse button. The new tool appears in the Toolbox.
To show the tools ungrouped, choose the Layout Ungroup command from the Toolbox Control
menu.



halftone pattern
A series of dots that simulate a color. The default halftone pattern is Bayer. Choose the 
Optimize Display to use a Diffused halftone. CorelPHOTO-PAINT applies a halftone to build 
gradients, or when your picture contains more colors than your printer or monitor supports, 
or more colors than the format you are converting to.



handles
Squares or circles on the Gadget Box, text frame box, and curve tool you use to manipulate 
a cutout, margins of text, or a shape's curve.



icon
The small picture representation of a minimized window. Click the down arrow to the right of 
a window's title bar to minimize it. Double-click an icon to open the window on your screen.



list box
Box in a dialog box that shows available selections, such as a file list box. Use the scroll bar 
to move up and down in the list. To select an item, click it and choose a command button. 
Double-click your selection to choose it and complete the command.



maximize 
You can maximize a CorelPHOTO-PAINT picture and the CorelPHOTO-PAINT desktop to the 
size of your screen by clicking the up arrow on the right corner of the title bar. To edit in Full 
Screen view, click the double arrow on the right corner of the help bar. To maximize a 
window that has been shrunk to an icon, double-click the icon, or click the icon and choose 
Maximize from the Control menu. You cannot maximize the Palette, Toolbox, or Width & 
Shape workbox.



menu bar
The horizontal bar below the program title bar that contains menu names. Each menu 
contains a list of commands you can choose.



minimize 
You can minimize or shrink a picture window and the CorelPHOTO-PAINT desktop to an icon 
by clicking the down arrow on the right corner of the title bar. You cannot minimize the 
Palette, Toolbox, or Width & Shape workbox.



mini-scroll bar    
Adjusts numerical values. Mini-scroll bars can be vertical or horizontal. Click the arrows to 
increase or decrease values by single increments. To quickly adjust the values, point to the 
box between the arrows. When your pointer is a double-sided arrow with lines through the 
center, drag the mouse to change the value. You can also type numbers in the text box to 
adjust numerical values.



option button
A button that allows you to choose one of several items. Click a button to select it. A 
selected button contains a filled dot. Unavailable choices are dimmed or do not appear.



Palette 
Workbox you display to view and change colors or tool settings. Choose Show Palette or Hide
Palette from the Display menu, or press Ctrl+P to display or remove your Palette.
The color selection box is on the left side of the Palette, and shows the selected setting 
value or the selected primary, secondary, and background colors. The rest of the Palette 
shows available colors or settings for the current tool. Each picture has its own palette. The 
palette of a 24 bit picture shows 256 of the available 16.7 million colors.
Use Palette Save As Palette to save the current set of colors to disk in a palette you can load 
into another picture.



picas
Unit of measurement. There are six picas in one inch and twelve points in one pica.



picture window
Each picture is loaded into its own picture window. You can load one picture and duplicate it 
20 times. Each open window increases the memory your system requires.



pixels
Unit of measurement. Individual dots on a screen or a printer.



points
Unit of measurement. There are twelve points in one pica and six picas in one inch.



press
Hold down the mouse button. Unless otherwise noted, press the left mouse button.



primary color
Many tools and commands use the primary color. To change your primary color, point in the 
Palette to the color you want and click the left mouse button. You can also select the 
Eyedropper tool, point to a color in your picture, and click the left mouse button. The new 
primary color appears in the color selection box on the left of the Palette .



printer halftone
Pattern of dots that simulates a color, used when you print a picture that has more colors 
than your printer supports.



retouch tools
Tools you use to add coloring and shading effects. The retouch tools are the contrast, 
brighten, tint, blend, smudge, and sharpen tools. You can also use filters to retouch pictures.



Screen Preview
Shows how changes will affect your picture before the changes are made. During Screen 
Preview, you can drag the dialog box aside to see more of the picture.



secondary color
Many tools and commands use the secondary color. To change your secondary color, point in
the Palette to the color you want and click the right mouse button. You can also select the 
Eyedropper tool, point to a color in your picture, and click the right mouse button. The new 
secondary color appears in the color selection box on the left of your Palette.



temporary files
CorelPHOTO-PAINT temporarily stores information in files on your hard disk if it runs out of 
memory. Set the drives/directories for CorelPHOTO-PAINT to use as temporary storage with 
the Preferences command. If you quit CorelPHOTO-PAINT abnormally, the files remain on 
your system and can be deleted.



text box
Box in a dialog box you can type in. For example, you type the name of a file in the File 
Name text box.



tile pattern 
Any small picture loaded from disk or the clipboard, to be used in a tile pattern. Use Tile 
Pattern to select the tile you want.



title bar
The horizontal bar at the top of windows that shows the title of the program, the title of the 
window, or information about the loaded picture (name, magnification rate, etc.). The left 
end of the title bar contains the Control menu box and the right end may contain minimize 
and maximize buttons.



Toolbox
Workbox containing the tools you use to create and retouch pictures and add special effects.
Choose Show Toolbox or Hide Toolbox from the Display menu, or press Ctrl+T to display or 
remove the Toolbox.
Click a tool with the left mouse button to choose it. Click a tool with the right mouse button 
for help on using the tool. Grouped tools display a triangle in the bottom right corner.



virtual memory
Allows CorelPHOTO-PAINT to behave as if there were more memory than is actually present 
in your system by storing temporary files in any free RAM and disk space.



Width & Shape workbox 
Workbox you display to view or change your tool width or shape. Choose Show Width & 
Shape or Hide Width & Shape from the Display menu or press Ctrl+W to display or remove 
the Width & Shape workbox. The value in the display box is in pixels even if you select 
another unit of measure. To change the current width, press one of the arrows, drag over the
display box and type a number, or click the triangle.



Windows 3.0
If you have to reinstall Windows 3.0 after installing CorelPHOTO-PAINT: Copy all files ending 
in .dll and .drv from the subdirectory where CorelPHOTO-PAINT is installed into your 
Windows\System subdirectory. If you have upgraded to Windows 3.1 this procedure is not 
necessary.



work area
Area of your picture you see in a picture window. If a picture extends beyond the work area, 
use the Hand tool or the scroll bars to move other areas into view. Use the Locator tool to 
display other areas in a duplicated picture. Use the Zoom Out commands to display more of 
a picture at once.



DMA I/O
Data is transferred by your system hardware from memory to some other device without 
being loaded into the microprocessor.



EMS
Expanded Memory Specification. A standard that allows personal computers to use more 
than 640K of RAM in DOS. EMS creates a 64K RAM window through which RAM in 64K 
sections can be swapped as needed.



memory address
A number code you can select to specify a location in random access memory.



port address
The location you assign for the interface between your computer and an external device, 
such as a printer. You can assign a port address to one device at a time.



      Blend Paintbrush Tool -- Blending Freehand
To blend areas:
1.Adjust the tool's width and shape.
2. Drag the arrow in the Palette to adjust the tool's effect.
3. Drag over areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Filter Blend
Finding and Selecting Tools
Selecting Tool Settings



      Brighten Paintbrush Tool -- Brightening Freehand
To brighten areas:
1.Adjust the tool's width and shape.
2. Drag the arrow in the Palette to adjust the tool's effect.
3. Drag over areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Filter Brightness and Contrast
Filter Color/Gray Map
Finding and Selecting Tools
Selecting Tool Settings



      Contrast Paintbrush Tool -- Changing Contrast Freehand
To adjust contrast in areas:
1.Adjust the tool's width and shape.
2. Drag the arrow in the Palette to adjust the tool's effect.
3. Drag over areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Filter Brightness and Contrast
Filter Equalize
Finding and Selecting Tools
Selecting Tool Settings



      Gradient Paint Roller Tool -- Filling an Area with a Gradient
To fill with a gradient:
1.Choose a secondary and background color.
2. Choose Gradient Type to adjust the look of the gradient.
3. Choose Color Tolerance to adjust the range of colors to fill.
4. Place the drop on the pointer inside the area you want to fill.
5. Click the mouse button inside the area you want to fill.

Related Topics
Convert To
Finding and Selecting Tools
Paint Roller
Palette Open Palette
Palette Range of Colors
Selecting Tool Colors
Tile Pattern Paint Roller
Undo
Zoom tool



      Smear Paintbrush Tool -- Smearing Colors Freehand
To smear areas:
1.Adjust the tool's width and shape.
2. Choose Soft Brush Settings to change the tool's effect.
3. Drag over the areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Finding and Selecting Tools
Smudge Spraycan



      Smudge Spraycan Tool -- Smudging Freehand
To smudge areas:
1.Adjust the tool's width and shape.
2. Drag over the areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Smear Paintbrush



      Tile Pattern Paint Roller Tool -- Filling an Area with a Tile Pattern
To fill with a tile pattern:
1.Open a tile pattern.
2.Choose Color Tolerance to adjust the range of colors to fill.
3.Place the drop on the pointer inside the area you want to fill.
4. Click the mouse button inside the area you want to fill.

Related Topics
Finding and Selecting Tools
Gradient Paint Roller
Paint Roller
Selecting Tool Colors
Undo
Zoom tool



      Tint Paintbrush Tool -- Tinting Freehand
To tint areas:
1.Adjust the tool's width and shape.
2. Choose a primary color. 
3. Drag over the areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Finding and Selecting Tools
Selecting Tool Colors



      Sharpen Paintbrush Tool -- Sharpening Freehand
To sharpen areas:
1.Adjust the tool's width and shape.
2. Drag the arrow in the Palette to adjust the tool's effect.
3. Drag over the areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Filter Sharpen
Finding and Selecting Tools
Selecting Tool Settings



CorelPHOTO-PAINT Tools

You use the tools in the Toolbox to create, add special effects, and retouch your pictures. To 
choose a tool, the Toolbox must be displayed.
For information on selecting tools, see Finding and Selecting Tools. 

Display Tools:
    Zoom changes the magnification of a picture.
    Locator displays selected area in all windows that contain the same duplicated pictures.
    Hand moves your picture vertically, horizontally, or diagonally.

Selection Tools:
    Box Selection defines rectangular areas.
    Magic Wanddefines areas with similar colors.
    Lasso defines irregular areas.
    Scissors defines polygonal areas.

Painting Tools:
    Text adds text to your picture.
    Eyedropper selects a color from the picture.
    Eraser erases areas of your picture.
    Color Replacer replaces the primary color with the secondary color.
    Local Undo undoes areas freehand.
    Airbrush shades areas freehand with a soft spray.
    Spraycan splatters colors freehand.
    Paint Roller fills enclosed areas with color.
    Tile Pattern Paint Roller fills enclosed areas with a repeating tile pattern.
    Gradient Paint Roller fills enclosed areas with a gradient.
    Paintbrush draws freehand shapes with a soft brush.
    Fountain Pen draws freehand shapes.
    Line draws single or joined lines.
    Curve draws single or joined curves.
    Hollow Box draws hollow boxes.
    Hollow Rounded Box draws hollow rounded boxes.
    Hollow Ellipse/Circle draws single or concentric hollow ellipses or circles.
    Hollow Polygon draws hollow polygons.
    Filled Box draws filled boxes.
    Filled Rounded Box draws filled rounded boxes.
    Filled Ellipse/Circle draws single or concentric filled ellipses or circles.
    Filled Polygon draws filled polygons.
    Clone paints one area of your picture with another selected area.



Retouch Tools:
    Contrast Paintbrush adjusts contrast freehand.
    Brighten Paintbrush changes the intensity of colors freehand.
    Tint Paintbrush changes color shades freehand.
    Blend Paintbrush smooths areas freehand.
    Smear Paintbrush smears colors freehand.
    Smudge Spraycan smudges colors freehand.
    Sharpen Paintbrush sharpens colors freehand.

Related Topics
Changing Your Tool Width and Shape
Selecting Tool Colors
Selecting Tool Settings



Finding and Selecting Tools

You use CorelPHOTO-PAINT tools to create, add special effects, and retouch pictures.
· To get help on using a tool, click the right mouse button on the tool.
· To choose a tool, the Toolbox must be displayed. 
· To choose a tool, point to it and click the left mouse button. The tool is highlighted to 

indicate it is selected.
· To choose a tool from a group, press the left mouse button on the triangle in the bottom 

right corner of the current tool. When the available tools appear, drag the mouse to the 
tool you want and release the mouse button. The tool appears in the Toolbox and is 
selected.
Press the blue arrow next to the group name to see which tools are included in the group.

Selection tools
Line tools
Paint Roller tools
Hollow shapes
Filled shapes
Smear/Smudge tools

· When you move the pointer over the picture window it changes shape to remind you 
which tool you selected.

· You can move the Toolbox by dragging its title bar
· To use most tools, choose the tool you want and point to where you want to start. Press 

the left mouse button to anchor the starting point, drag the mouse until you have the look 
you want, and release the mouse button.

Related Topics
Changing Your Tool Width and Shape
Laying Out the Toolbox
CorelPHOTO-PAINT Tools
Selecting Tool Colors
Selecting Tool Settings



Selecting Tool Colors

The Palette workbox is where you can select the primary, secondary, and background colors 
for your picture. Your Palette changes depending on your picture and the tool you are using. 
The colors you choose are displayed in the color selection box.
To select new colors, the Palette must be displayed.
There are two ways to choose colors:
· Point to a color in the Palette and click the appropriate mouse button to select your colors.

 
· Use the Eyedropper tool to pick up a color from your picture. Click the appropriate 
mouse button to select your colors.  

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Folding and Unfolding the Palette
CorelPHOTO-PAINT Tools
Selecting Tool Settings
Working with Different Numbers of Colors



Selecting Tool Settings

The Palette workbox is where you can change settings for some of the retouch tools. The 
settings you choose are displayed in the color selection box.
To select new settings, the workbox must be displayed.
These are the ways to change settings for some of the retouch tools:
· Point to the arrow in the workbox and drag to the setting you want.
· Point to the setting you want and click the left mouse button. The arrow moves to the new 

setting.
· Use the mini-scroll bar in the color selection box.

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Folding and Unfolding the Palette
CorelPHOTO-PAINT Tools
Selecting Tool Colors



Changing Your Tool Width and Shape

You use the Width & Shape workbox to change the width and shape of some tools.
To change your tool width or shape in the Width & Shape workbox, it must be displayed. 

To change your tool width and shape:
· Click or press one of the arrows on the mini-scroll bar.
· Click the shape button on the left side of the workbox.

Related Topics
Finding and Selecting Tools
CorelPHOTO-PAINT Tools
Selecting Tool Colors
Selecting Tool Settings



      Zoom Tool -- Zooming In and Out with the Zoom Tool
To change the magnification of a picture:
1.Point to the area you want to zoom.
2.Click the left mouse button to zoom in.
3. Click the right mouse button to zoom out.
4. Continue clicking the mouse button to cycle through the Zoom command 
percentages.

Related Topics
Duplicate
Finding and Selecting Tools
Locator
Zooming In and Out with the Zoom Commands



      Hand Tool -- Moving Areas of Your Picture into View
To move your picture with the Hand tool:
1.Point to the picture you want to move.
2.Drag the picture to bring the area you want into view.

Related Topics
Duplicate
Finding and Selecting Tools
Locator
Scrolling



      Locator Tool -- Viewing the Same Area in Multiple Windows
To locate the same area of a picture in two or more windows:
· Click in one picture on the area you want to show in all windows that contain duplicate 

copies.

Related Topics
Duplicate
Finding and Selecting Tools
Hand
Scrolling
Zoom tool
Zooming In and Out with the Zoom Commands



      Eyedropper Tool -- Picking Up a Color from the Screen
To pick up a color from the screen with the Eyedropper tool:
1.Point to the color you want to pick up from your picture.
2.Click the appropriate mouse button to select your colors.
3. Select a tool or command to use with the color you picked up with the Eyedropper.

Related Topics
Finding and Selecting Tools
Selecting Tool Colors
Working with Different Numbers of Colors



      Box Selection Tool -- Defining a Rectangular Area
To define a cutout with the Box Selection tool:
1.Select a background color if you plan to cut or move the cutout.
2.Press the left mouse button to anchor the starting point.
3.Drag to surround the area you want.
4. Release the mouse button to complete the cutout.

Related Topics
Finding and Selecting Tools
Lasso
Magic Wand
Manipulating Defined Areas
Scissors



      Lasso Tool -- Defining an Irregular Area
To define a cutout with the Lasso tool:
1.Select a background color if you plan to cut or move the cutout.
2.Press the left mouse button to anchor the starting point.
3.Drag to surround the area you want to define.
4.Release the mouse button to complete the cutout.

Related Topics
Box Selection
Finding and Selecting Tools
Magic Wand
Manipulating Defined Areas
Scissors



      Scissors Tool -- Defining a Polygonal Area
To define a cutout with the Scissors tool:
1.Select a background color if you plan to cut or move the cutout.
2.Click the mouse button to anchor the starting point.
3.Continue clicking around the area you want to define.
4. Double-click to end the last line and complete the cutout.

Related Topics
Box Selection
Finding and Selecting Tools
Lasso
Magic Wand
Manipulating Defined Areas



      Magic Wand Tool -- Defining Areas with Similar Colors
To define an area with the Magic Wand tool:
1.Choose Color Tolerance to adjust the range of colors for selection.
2.Point to the area you want to select and click the left mouse button.

Related Topics
Box Selection
Finding and Selecting Tools
Lasso
Manipulating Defined Areas
Scissors



Manipulating Defined Areas

Define the cutout with a selection tool and a marquee surrounds the selected area.
A Gadget Box with handles on its corners is also displayed so you can shrink or stretch the 
cutout.
To permanently paste the cutout, click outside the Gadget Box or choose a tool.
You can manipulate cutouts in the following ways:
· Point to a handle on the Gadget Box and drag to shrink or stretch the cutout.

Hold down Shift while you drag for proportional resizing.
· Point inside the Gadget Box and drag to move the cutout to another location.

Drag with the left mouse button to make the cutout opaque.
Drag with the right mouse button to make the background color of the cutout transparent.
Hold down Shift while you drag to leave a single copy behind.
Hold down Ctrl while you drag to leave a trail of copies behind.
You can also use the arrow keys to move the cutout one pixel at a time.

· Choose a command from the Edit menu to manipulate the cutout in other ways. For 
example, you can apply filters to the cutout, flip, invert, outline, and rotate the cutout with
Edit menu commands.

Related Topics
Box Selection
Edit Menu
Lasso
Magic Wand
Scissors



      Local Undo Tool -- Undoing Some Changes
To undo some changes:
1. just the tool's width and shape.
2. Drag over areas you want to return to their previous look.

Related Topics
Changing Your Tool Width and Shape
Color Replacer
Eraser
Finding and Selecting Tools
Undo



      Eraser Tool -- Erasing Parts of Your Picture
To use the Eraser tool:
1.Choose a background color.
2. Adjust the tool's width and shape.
3. Drag over areas you want to erase.

Related Topics
Changing Your Tool Width and Shape
Clear
Color Replacer
Finding and Selecting Tools
Selecting Tool Colors



      Text Tool -- Adding Text to Your Picture
To add text to your picture:
1.Select a font.
2.Choose a secondary color for your text.
3.Choose the Text tool and type your text in the Enter Text dialog box.
4. Choose OK.
5. To make changes to your text, do so before you paste it.
6. Click outside the Text Frame or choose another tool to paste the text.

Related Topics
Changing Your Font
Finding and Selecting Tools
Selecting Tool Colors



      Paint Roller Tool -- Filling an Area with Color
To fill an area with color:
1.Choose a primary color.
2.Choose Color Tolerance to adjust the range of colors to fill.
3.Place the drop on the pointer inside the area you want to fill.
4. Click the mouse button inside the area you want to fill.

Related Topics
Finding and Selecting Tools
Gradient Paint Roller
Selecting Tool Colors
Tile Pattern Paint Roller
Undo
Zoom tool



      Spraycan Tool -- Splattering Color with the Spraycan
To use the Spraycan:
1.Choose a primary color.
2.Adjust the tool's width and shape.
3. Point to the area you want to spray.
4. Drag over the areas you want to spray.

Related Topics
Brush Style
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors



      Airbrush Tool -- Shading with the Airbrush
To use the Airbrush tool:
1.Choose a primary color.
2.Adjust the tool's width and shape.
3. Choose Soft Brush Settings to change the tool's effect.
4. Drag over the areas you want to spray.

Related Topics
Brush Style
Changing Your Tool Width and Shape
Convert To
Finding and Selecting Tools
Selecting Tool Colors



      Paintbrush Tool -- Brushing Freehand
To use the Paintbrush tool:
1.Choose a primary color.
2.Adjust the tool's width and shape.
3. Choose Soft Brush Settings to change the tool's effect.
4. Point to where you want to start.
5. Drag to paint freehand.

Related Topics
Brush Style
Changing Your Tool Width and Shape
Convert To
Finding and Selecting Tools
Selecting Tool Colors



      Fountain Pen Tool -- Drawing Freehand Shapes
To use the Fountain Pen tool:
1.Choose a primary color.
2.Adjust the tool's width and shape.
3. Drag over the area you want to change.
4. You can click the right mouse button on a color in your picture to select it as the 
primary color.

Related Topics
Brush Style
Changing Your Tool Width and Shape
Finding and Selecting Tools
Selecting Tool Colors



      Color Replacer Tool -- Replacing One Color with Another
To replace colors:
1.Choose a primary color (the color you want to change) and a secondary color (the color 

you want the Color Replacer to use).
2.Adjust the tool's width and shape.
3. Choose Color Tolerance to adjust the range of colors to replace.
4. Drag over areas you want to change.

Related Topics
Changing Your Tool Width and Shape
Convert To
Finding and Selecting Tools
Selecting Tool Colors



      Curve Tool -- Drawing Single and Joined Curves
To draw a curve:
1.Choose a primary color.
2.Adjust the tool's width and shape.
3. Press the left mouse button to anchor the starting point.
4. Drag to where you want the curve to end.
5. Use the handles to adjust the curve.
6. Click outside the curve to paste it.

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Line
Selecting Tool Colors



      Line Tool -- Drawing Single and Joined Lines
To draw a line:
1.Choose a primary color.
2.Adjust the tool's width and shape.
3. Press the left mouse button to anchor the starting point.
4. Drag to where you want to end the line.
5. You can also draw joined lines or rays joined at a single point.

Related Topics
Brush Style
Changing Your Tool Width and Shape
Curve
Finding and Selecting Tools
Selecting Tool Colors



      Hollow Box Tool -- Drawing a Hollow Box
To draw a box:
1.Choose a primary color.
2. Adjust the width of the border.
3. Press the left mouse button to anchor the beginning of the shape.
4. Drag to draw the shape.

Related Topics
Changing Your Tool Width and Shape
Filled Box
Finding and Selecting Tools
Hollow Rounded Box
Selecting Tool Colors



      Filled Box Tool -- Drawing a Filled Box
To draw a filled box:
1.Choose a primary  and secondary color.
2. Adjust the width of the border.
3. Press the left mouse button to anchor the starting point.
4. Drag to draw the shape.

Related Topics
Changing Your Tool Width and Shape
Filled Rounded Box
Finding and Selecting Tools
Hollow Box
Selecting Tool Colors



      Hollow Rounded Box Tool -- Drawing a Hollow Rounded Box
To draw a rounded box:
1.Choose a primary color.
2. Adjust the width of the border.
3. Press the left mouse button to anchor the starting point.
4. Drag to draw the shape.

Related Topics
Changing Your Tool Width and Shape
Filled Rounded Box
Finding and Selecting Tools
Hollow Box
Selecting Tool Colors



      Filled Rounded Box Tool -- Drawing a Filled Rounded Box
To draw a filled rounded box:
1.Choose a primary and secondary color.
2. Adjust the width of the border.
3. Press the left mouse button to anchor the starting point
4.  Drag to draw the shape.

Related Topics
Changing Your Tool Width and Shape
Filled Box
Finding and Selecting Tools
Hollow Rounded Box
Selecting Tool Colors



      Hollow Ellipse/Circle Tool -- Drawing a Hollow Ellipse/Circle
To draw a hollow ellipse/circle:
1.Choose a primary color.
2. Adjust the width of the border.
3. Press the left mouse button to anchor the center point.
4. Drag to draw the shape.

Related Topics
Changing Your Tool Width and Shape
Filled Ellipse/Circle
Finding and Selecting Tools
Selecting Tool Colors



      Filled Ellipse/Circle Tool -- Drawing a Filled Ellipse/Circle
To draw a filled ellipse/circle:
1.Choose a primary and secondary color.
2. Adjust the width of the border.
3. Press the left mouse button to anchor the center point.
4. Drag to draw the shape.

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Hollow Ellipse/Circle
Selecting Tool Colors



      Hollow Polygon Tool -- Drawing a Hollow Polygon
To draw a hollow polygon:
1.Choose a primary color.
2. Adjust the width of the border.
3. Click the mouse button to anchor the starting point.
4. Continue clicking to draw the shape.
5. Double-click to end the last line and complete the shape.

Related Topics
Changing Your Tool Width and Shape
Filled Polygon
Finding and Selecting Tools
Selecting Tool Colors



      Filled Polygon Tool -- Drawing a Filled Polygon
To draw a filled polygon:
1.Choose a primary and secondary color.
2. Adjust the width of the border.
3. Click the mouse button to anchor the starting point.
4. Continue clicking to draw the shape.
5. Double-click to end the last line and complete the shape.

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Hollow Polygon
Selecting Tool Colors



      Clone Tool -- Replacing One Area with Another Freehand
To use the Clone tool:
1.Adjust the tool's width and shape.
2. Choose Soft Brush Settings to change the tool's effect.
3. Click the right mouse button on the area you want to clone (source).
4. Drag to begin cloning.

Related Topics
Changing Your Tool Width and Shape
Finding and Selecting Tools
Paste From
Pasting from the Clipboard
Working with Different Numbers of Colors



The Help Menu

You use Help menu commands to open the CorelPHOTO-PAINT Help program and learn more 
about commands, procedures, tools, and shortcuts. You can also use Help menu commands 
to get information about your current picture, your system, and the version of CorelPHOTO-
PAINT you are using.
To choose a Help menu command, click Help and choose a command.
To learn how to use on-line help, choose Using Help from the Help menu in the CorelPHOTO-
PAINT Help program.

Help Menu Commands
Index Lists topics you can choose from.
For Beginners Explains basic CorelPHOTO-PAINT information.
Commands Lists and explains CorelPHOTO-PAINT menus.
Procedures Lists topics that help you create, edit, view, and print pictures, use tools, work 

with files, and work with colors.
Shortcuts Explains shortcuts for choosing commands and selecting options.
Tools Explains how to use CorelPHOTO-PAINT tools.
System Info Displays information about your current picture, memory, disk space, and 

hardware.



For Beginners

Welcome to CorelPHOTO-PAINT's help for beginners.
If you're unfamiliar with the CorelPHOTO-PAINT program, choose from the topics listed below.
For more help on CorelPHOTO-PAINT, choose a command from the CorelPHOTO-PAINT Help 
menu, choose help in any dialog box, browse through the help system, and read the 
CorelPHOTO-PAINT User's Guide.
To learn about CorelPHOTO-PAINT Help features, point to the picture of the key and press the
left mouse button.
To choose a Help topic with the mouse, point to words that have a solid underline. When 
your pointer becomes a hand, click the left mouse button. To read a glossary term, point to 
words with a dotted underline and press the left mouse button.
To choose a Help topic with the keyboard, tab to words that have a solid underline and press 
Enter. To read a glossary term, tab to words with a dotted underline and press and hold 
Enter.
To learn how to use Windows on-line help, choose Using Help from the Help menu in the 
CorelPHOTO-PAINT Help program. For help running Windows, check your Microsoft Windows 
User's Guide.

Help for Beginners
Changing Your Tool Width and Shape
Finding and Selecting Tools
Scrolling
Selecting Tool Colors
Selecting Tool Settings
Using Filters
Using CorelPHOTO-PAINT Windows
Viewing Colors on Your Screen
Welcome to CorelPHOTO-PAINT
Working with Different Numbers of Colors



Using CorelPHOTO-PAINT Windows

CorelPHOTO-PAINT keeps your Toolbox, Palette, and Width & Shape workbox in individual 
workboxes you can show, hide, and move for control of your desktop layout.
CorelPHOTO-PAINT loads pictures into picture windows. The window's title bar displays the 
picture's name, magnification percentage, and the order in which it was opened or 
duplicated.
You can move, resize, and close a window, or reduce it to an icon.
· To move a window to another location, drag the window's title bar.
· To resize a window, place your pointer on a window border. When your pointer becomes a 

double-sided arrow, drag to resize the window.
· To close, maximize, and minimize a window, choose appropriate commands from the 

window's Control menu.

Related Topics
Duplicate
Open Picture
Showing or Hiding Workboxes



Scrolling

You use scroll bars to display parts of your picture that don't fit in the picture window and 
portions of lists that are out of view. You can also use the Hand to move a picture around a 
window. The Hand works like scroll bars, but it also lets you move diagonally.
Mini-scroll bars let you cycle through numeric fields in a dialog box instead of typing 
numbers.

To use a scroll bar:    
· Click a scroll arrow to move line-by-line.
· Press a scroll arrow to move continuously.
· Drag the scroll box to the general location you want to see.
· Click inside the scroll bar to move the scroll box to that location.

To use a mini-scroll bar:    
· Click a scroll arrow to increase or decrease numbers by single increments.
· Press a scroll arrow to continuously change numbers.
· Point to the middle of the scroll bar. When your pointer is a double-sided arrow with lines 

through the center, drag up or down to scroll through available values.



CorelPHOTO-PAINT Commands

You choose CorelPHOTO-PAINT commands from the menus that run across the top of the 
CorelPHOTO-PAINT desktop.
To choose a command, click the menu name in the menu bar and click the command you 
want. Some commands are on cascading menus
File Menu You use File menu commands to start new pictures; load and save pictures; 

clear a picture window to the background color print pictures; select your 
printer and change printer options; and exit CorelPHOTO-PAINT.

Edit Menu You use Edit menu commands to change the color format of pictures, apply 
filters, correct mistakes, copy or cut to the clipboard or to disk, paste from the 
clipboard or disk, and flip, rotate, invert and outline pictures or cutouts.

Display Menu You use Display menu commands to zoom in or out on your picture, set the 
layout of your desktop, and clear the screen of everything except your picture.

Font Menu You use Font menu commands to select fonts and to choose a different loaded
font.

Options Menu You use Options menu commands to adjust your palette, change tool shapes, 
adjust soft brush settings, load tile patterns, select startup preferences, and 
choose other program options.

Window Menu You use Window menu commands to duplicate an opened picture, rearrange 
CorelPHOTO-PAINT picture windows, rearrange minimized pictures, and 
change your active picture.

Help Menu You use Help menu commands to open the CorelPHOTO-PAINT Help program 
and learn more about commands, procedures, tools, and shortcuts. You can 
also use Help menu commands to get information about your current picture, 
your system, and the version of CorelPHOTO-PAINT you are using.

Control Menu You use Control menu commands on the CorelPHOTO-PAINT program and 
picture windows to move, close, restore, and change the size of the window. A 
picture window Control menu also has the Image Info command and the 
Image Resolution command. Control menu commands on the CorelPHOTO-
PAINT workboxes move and hide the workboxes. The Toolbox workbox Control 
menu also has the Layout command, and the Palette workbox Control menu 
also has the Fold/Unfold command.



CorelPHOTO-PAINT Procedures

Editing a Picture Lists procedures for 
creating and improving 
pictures.

Painting with
    CorelPHOTO-PAINT

Lists procedures for 
using CorelPHOTO-PAINT
tools.

Printing Lists procedures for 
printing pictures.

Retouching and
    Enhancing Pictures

Lists procedures for 
using tools and filters to 
improve images.

Working with Colors Lists procedures you use
to work with different 
color formats, create 
colors and gradients, 
load and change 
palettes, and manipulate
the colors in your 
pictures.

Working with Files Lists procedures for 
working with 
CorelPHOTO-PAINT files.

Working with 
Windows

Lists procedures for 
working with windows in 
CorelPHOTO-PAINT.

CorelPHOTO-PAINT Shortcuts

CorelPHOTO-PAINT provides many shortcuts to help you work more efficiently. You will often 
find the use of accelerator keys and mouse double-clicks to be faster than choosing 
commands from menus. In addition, many CorelPHOTO-PAINT tools can be constrained so 
that you can draw perfect lines and geometric shapes.
Choose a topic below for more information.
Keyboard Shortcuts
Double-click Shortcuts
Tool Constraints



Keyboard Shortcuts

Use accelerator keys, shown beside some commands, to select a command. For example, 
use Ctrl+X to exit CorelPHOTO-PAINT. You can also hold down Alt and type the underlined 
letter in a menu and the underlined letter in the command. For example, use the following 
keys to cut, copy, and paste: Alt+E,T to cut, Alt+E,C to copy, Alt+E,P to paste.

CorelPHOTO-PAINT Keystrokes
This key... ...does this.

Alt+BkSp undoes recent changes.
Alt+F4 closes CorelPHOTO-PAINT.
Arrow keys moves a cutout one pixel at a time.
Ctrl+1 returns a picture to one-to-one view.
Ctrl+A shows or removes the Width & Shape, Palette, and Toolbox workboxes.
Ctrl+D duplicates the current picture.
Ctrl+F4 closes the current picture.
Ctrl+F6 switches to the next picture.
Ctrl+Ins copies a defined area.
Ctrl+P shows or removes the Palette workbox.
Ctrl+S saves your picture.
Ctrl+T shows or removes the Toolbox workbox.
Ctrl+W shows or removes the Width & Shape workbox.
Esc erases some tools' effects before you release the mouse button.
Shift+Del cuts a defined area.
Shift+F4 tiles the windows on your CorelPHOTO-PAINT desktop.
Shift+F5 cascades the windows on your CorelPHOTO-PAINT desktop.
Shift+Ins pastes a cutout from the clipboard.

Windows Keystrokes
This key... ...does this.
Alt+spacebar opens the program Control menu.
Alt+up or down arrow opens a drop-down list after you tab to the list box.
Arrow keys moves within a list, display box, or group of choices in a dialog box.
Enter chooses a highlighted command, selects an item from a list, and completes 

commands.
Esc cancels a dialog box.
F1 opens the on-line Help system and displays the Index.
Shift+Tab moves from one area to another in a dialog box in reverse order.
Spacebar chooses a selection in a list or a check box option. Press the spacebar again to 

unselect the option.
Tab moves from one area to another in a dialog box.

Related Topics
CorelPHOTO-PAINT Shortcuts



Double-click Shortcuts

For some tools, double-clicking is a quick way to modify some CorelPHOTO-PAINT settings or 
to select some options.
Click the brush style button in the Width & Shape workbox to display the Select a Brush 
Style dialog box.

Airbrush
Blend Paintbrush
Box Selection
Clone
Color Replacer
Contrast 

Paintbrush
Control menu
Curve
Eraser
Fountain Pen
Gradient Paint 

Roller
Line

Local Undo
Magic Wand
Paint Roller
Paintbrush
Palette colors
Sharpen Paintbrush
Smudge Paintbrush
Spraycan
Tile Pattern Paint 

Roller
Tint Paintbrush
Zoom

Related Topics
CorelPHOTO-PAINT Shortcuts
Tools



Tool Constraints

For some tools, holding down Shift while you drag the mouse constrains the shape or 
direction of the effect. Press the spacebar to switch between horizontal and vertical 
constraint. Release the Shift key to use the tools normally.

Airbrush
Box Selection
Box tools
Clone
Color Replacer
Ellipse tools
Eraser

Fountain Pen
Line tools
Local Undo
Paintbrush
Polygon tools
Scissors

Related Topics
CorelPHOTO-PAINT Shortcuts
Tools



Displaying System Information

You use System Info to read about your current picture, your display, and your printer. You 
can also see how much memory and disk space is installed and remains in your computer.

Image Shows you the size, resolution, and number of colors in your picture.
Screen Shows you the dpi your screen can display. The higher the number, the 

sharper your display.
Printer Shows you the name of the currently selected printer and the dpi the 

printer can print. The higher the number, the sharper your printout will 
be. You can change the selected printer and printer settings with Printer 
Setup.

Computer Memory Shows you how much memory and disk space is installed in your 
computer and how much remains. You can set virtual memory paths with
Preferences.

Related Topics
Previewing a Picture



Trademarks and Tradenames

CorelPHOTO-PAINT is a trademark of COREL CORPORATION.
Other product names mentioned may be trademarks or registered trademarks of their 
respective companies. Some trademarks may be registered in countries other than the U.S.



The Display Menu

You use Display menu commands to zoom in or out on your picture, set the layout of your 
desktop, and clear the screen of everything except your picture.
To choose a Display menu command, click Display and choose the command. Some 
commands are on cascading menus.

Display Menu Commands
Zoom Magnifies or shrinks the active picture.
100% (No Zoom) Returns a picture to one-to-one view.
Zoom To Fit Shrinks or magnifies your picture to fit your CorelPHOTO-PAINT desktop.
Workboxes Opens or closes the Width & Shape, Palette, and Toolbox workboxes.
Full Screen Removes the title bar and menu bar from your screen and maximizes your 

desktop. You can edit a picture in Full Screen mode.
Show Screen Removes everything but the active picture from your screen. You cannot 

edit a picture in Show Screen mode.
Optimize Display Improves the on-screen look of your pictures if they contain more colors 

than your monitor supports.



Display Zoom Commands -- Zooming In and Out with the Zoom Commands

To shrink or magnify a picture:
· Choose the Zoom percentage you want from the Display menu.
· If you zoom by 1600%, CorelPHOTO-PAINT displays a grid that shows individual pixels.

Related Topics
100% (No Zoom)
Duplicate
Locator
Zoom To Fit
Zoom tool



Display 100% (No Zoom) Command -- Viewing Your Picture with No Zoom

To return to 100% view:
· Choose 100% (No Zoom) from the Display menu.

Related Topics
Zoom To Fit
Zoom tool
Zooming In and Out with the Zoom Commands



Display Zoom To Fit Command -- Zooming to Fit

To quickly display your entire picture:
· Choose Zoom to Fit.

Related Topics
Zoom tool
Zooming In and Out with the Zoom Commands



Display Workboxes Commands -- Showing or Hiding Workboxes

To show or hide workboxes:
· Choose a Workboxes Show command to display the Width & Shape, Palette, or Toolbox 

workbox. Workboxes Show All displays all workboxes.
· Choose a Workboxes Hide command to remove a workbox. Workboxes Hide All 
removes all workboxes.

Related Topics
Editing Your Picture Full Screen
Fold/Unfold
Layout



Display Full Screen Command -- Editing Your Picture Full Screen

To edit your picture full screen:
1.Choose Full Screen.
2.Click the double arrows on the right side of the help bar or press Ctrl+F to return to normal

view.

Related Topics
Showing or Hiding Workboxes
Viewing Only Your Picture



Display Show Screen Command -- Viewing Only Your Picture

To view only the picture:
1 Choose OK to view your active picture full-screen.
2 Press Esc to return to the normal CorelPHOTO-PAINT screen.

Related Topics
Editing Your Picture Full Screen
Showing or Hiding Workboxes



Display Optimize Display Command -- Optimizing Your Display

To enhance your screen display:
· Select Optimize Display.

Related Topics
Selecting Preferences



The Options Menu

You use Options menu commands to change your palette, change tool shapes and settings, 
load a tile pattern, select startup preferences, and choose other program options.
To choose an Options menu command, click Options and choose the command. Some 
commands are on cascading menus.

Options Menu Commands
Brush Style Changes the shape and size of all paintbrush tools and the Airbrush, 

Clone, Color Replacer, Curve, Eraser, Fountain Pen, Line, and Local 
Undo tools.

Color Tolerance Specifies a color range to fill, select, or replace with the paint roller 
tools, Magic Wand and Color Replacer.

Gradient Type Changes the direction and brightness of the gradient for the Gradient
Paint Roller.

Palette All Colors Adjusts all colors in the palette.
Palette Color Picker Adjusts individual colors in a palette.
Palette Range of Colors Creates gradations of colors in a palette.
Palette Single Colors Adjusts individual colors in a palette. 
Palette Open Palette Loads a palette previously saved to disk.
Palette Save As PaletteSaves a palette to disk.
Preferences Adjusts some settings for program startup, context sensitive help, 

CorelPHOTO-PAINT's virtual memory path, and the unit of measure.
Soft Brush Settings Adjusts the effects of the "soft" tools.
Tile Pattern Loads a picture from disk or the clipboard to use with the Tile Pattern 

Paint Roller tool.



Options Brush Style Command -- Changing Your Brush Style

To change the brush style:
1.Click a shape.
2.Click Set Size to change the tool width.
3.Choose OK.

Related Topics
Tools



Setting Your Tool Width

To set your drawing width in the Set the Drawing Width dialog box:
1.Select a Units option.
2. Use the Drawing width mini-scroll bar to change your tool width.
3. Choose OK.

Related Topics
Changing Your Brush Style



Options Color Tolerance Command -- Specifying Color Tolerance

To specify colors to fill, replace, or select:
1.Use the mini-scroll bars to select a color tolerance range.
2. Choose OK.

Related Topics
Color Replacer
Gradient Paint Roller
Magic Wand
Paint Roller
Tile Pattern Paint Roller
Working with Different Numbers of Colors



Options Gradient Type Command -- Changing the Direction of Your Gradient

To change the gradient's effect:
1.Click a gradient direction.
2.Use the mini-scroll bar to select an amount of brightness.
3. Choose OK.

Related Topics
Gradient Paint Roller
Palette Open Palette
Palette Range of Colors
Working with Different Numbers of Colors



Options Palette Color Picker Command -- Adjusting Individual Colors

To adjust the selected primary color:
1.Select a color model from the Model drop-down list.
2. Select a channel from the Channel drop-down list.
3. Adjust the selected channel level with the Color Slider.
4. Choose Show Colors to see the available colors in the Color Refiner box.
5. Click on the color you want within the Color Refiner box.
6. Choose OK.

Related Topics
Convert To
Mixing RGB Colors
Palette All Colors
Palette Open Palette
Palette Range of Colors
Palette Save As Palette
Palette Single Colors
Working with Different Numbers of Colors



Options Palette All Colors Command -- Changing All the Colors in Your Picture

To adjust the entire palette:
1.Drag the Brightness and Contrast arrows to adjust the palette.
2. Adjust color settings in the Color box.
3. Choose OK.

Related Topics
Convert To
Palette Open Palette
Palette Range of Colors
Palette Save As Palette
Palette Single Colors
Working with Different Numbers of Colors



Options Palette Single Colors Command -- Creating a New Color

To change an individual color:
1.Choose a primary color. 
2.Select a color model from the Model drop-down list.
3. Adjust the color values.
4. Choose OK.

Related Topics
Convert To
Mixing RGB Colors
Palette All Colors
Palette Color Picker
Palette Open Palette
Palette Range of Colors
Palette Save As Palette
Working with Different Numbers of Colors



Options Palette Range of Colors Command -- Creating a Range of Colors

To create a range of colors:
1.Choose the colors you want to change.
2. Select a color model from the Model drop-down list.
3. Use the mini-scroll bars to adjust the color values.
4. Click Build Range.
5. Choose OK.

Related Topics
Convert To
Mixing RGB Colors
Palette All Colors
Palette Color Picker
Palette Open Palette
Palette Save As Palette
Palette Single Colors
Working with Different Numbers of Colors



Options Palette Open Palette Command -- Loading a Palette

To open a previously saved palette:
1.Select the drive and directory you want.
2. Click a file in the File Name list box.
3. Choose OK.

Related Topics
Convert To
Palette Save As Palette
Selecting Tool Colors
Selecting Tool Settings
Working with Different Numbers of Colors



Options Palette Save As Palette Command -- Saving a Palette

To save a palette:
1.Select the drive and directory you want.
2. Type a name for the palette in the File Name text box.
3. Choose OK.

Related Topics
Convert To
Palette Open Palette
Selecting Tool Colors
Selecting Tool Settings
Working with Different Numbers of Colors



Mixing RGB Colors

Below is a list of RGB values for common colors. Color values are listed in the order you 
adjust them: Red, Green, and then Blue. Each value is separated by a comma.
To mix colors for a gray scale picture, first convert the picture to a 256 Color or 24 Bit Color 
picture.
If the colors don't look right, you can adjust the brightness of your pictures on-screen with 
the Monitor Gamma option in the Preferences dialog box.
Red Green Blue
Dark: 85, 0, 0
Medium: 170, 0, 0
Bright: 255, 0, 0
Light: 255, 85, 85
Brick: 160, 64, 64
Cherry: 255, 0, 85
Maroon: 192, 0, 80
Pink: 255, 170, 170
Salmon: 255, 144, 128
Violet-Red: 255, 0, 170

Dark: 0, 85, 0
Medium: 0, 170, 0
Bright: 0, 255, 0
Light: 170, 255, 170
Forest: 85, 170, 0
Grass: 0, 176, 112
Lime: 170, 255, 85
Olive: 120, 144, 0
Pine: 43, 85, 0
Sea Green: 170, 255, 255
Spring Green: 208, 255, 

160
Yellow-Green: 192, 255, 0

Dark: 0, 0, 85
Medium: 0, 0, 170
Bright: 0, 0, 255
Light: 85, 85, 255
Baby Blue: 170, 170, 255
Blue-Gray: 144, 144, 160
Cobalt Blue: 96, 80, 208
Cornflower: 170, 170, 255
Navy: 0, 0, 128
Periwinkle: 224, 208, 255
Sky Blue: 85, 170, 255
Violet Blue: 170, 0, 255

Cyan (Blue-Green) Earthtones Flesh
Dark: 0, 85, 85
Medium: 0, 170, 170
Bright: 0, 255, 255
Light: 85, 255, 255
Aquamarine: 160, 255, 

224
Blue-Green: 0, 255, 170
Green-Blue: 0, 128, 112
Pale: 170, 255, 255
Turquoise: 0, 176, 160

Dark Brown: 128, 64, 0
Brown: 176, 80, 0
Burnt Sienna: 176, 64, 0
Copper: 176, 96, 64
Indian Red: 144, 0, 0
Mahogany: 192, 64, 0
Raw Sienna: 176, 96, 0
Raw Umber: 144, 96, 0
Rust: 160, 80, 48
Sepia: 144, 64, 0
Tan: 255, 144, 96

Dark: 170, 85, 85
Medium: 255, 170, 170
Light: 255, 192, 192
Apricot: 255, 224, 192
Peach: 255, 208, 192

Gray Magenta (Red-Violet) Orange
Black: 0, 0, 0
Very Dark: 64, 64, 64
Dark: 85, 85, 85
Medium: 128, 128, 128
Light: 170, 170, 170
Very Light: 213, 213, 213
White: 255, 255, 255
Silver: 208, 208, 224

Dark: 85, 0, 85
Medium: 170, 0, 170
Bright: 255, 0, 255
Light: 255, 85, 255
Mulberry: 170, 0, 85
Orchid: 255, 85, 170
Pale: 255, 170, 255
Red Violet: 255, 0, 160

Dark: 128, 85, 0
Medium: 170, 113, 0
Bright: 255, 170, 0
Light: 255, 170,85
Bittersweet: 255, 112, 80
Burnt Orange: 224, 96, 0
Melon: 255, 128, 112
Orange-Red: 255, 80, 0
Tangerine: 255, 112, 0
Yellow-Orange: 255, 144, 
0

Purple Yellow
Dark: 43, 0, 85
Medium: 85, 0, 170
Bright: 128, 0, 255
Light: 128, 85, 255
Violet: 96, 0, 112
Lavender: 213, 170, 255
Plum: 160, 0, 112

Dark: 85, 85, 0
Medium: 170, 170, 0
Bright: 255, 255, 0
Light: 255, 255, 170
Amber: 255, 170, 0
Cream: 255, 255, 208
Gold: 176, 112, 64
Goldenrod: 255, 176, 0
Green-Yellow: 170, 255, 0
Lemon: 255, 255, 85
Maize: 255, 176, 112
Orange-Yellow: 255, 208, 0



Options Preferences Command -- Selecting Preferences

To change CorelPHOTO-PAINT settings:
1.Choose the options you want.
2. Click Memory Options to set up or disable virtual memory.
3. Click Monitor Gamma to change how bright your pictures appear on-screen.
4. Click VGA Palette to try to view more levels of gray.
5. Choose OK.
6. Exit Windows and restart the program for the changes to take effect.

Related Topics
Optimize Display



Preferences Dialog Box Options
At Startup
Units
Display Help Bar
Keep Thumbnail Files
Monitor Gamma
VGA Palette
Memory Options

Related Topics
Adjusting the On-screen Brightness of Your Pictures
Preferences
Selecting Memory Options
Viewing More Levels of Gray



Adjusting the On-screen Brightness of Your Pictures

To adjust how your pictures look on-screen:
1.Use the Monitor Gamma mini-scroll bar to select a number from 1.0 to 2.0.
2. Choose OK.

Related Topics
Optimize Display
Preferences
Viewing More Levels of Gray



Viewing More Levels of Gray

To view more grays on a VGA monitor:
1.Save all work.
2.Choose Test Hardware.
3. Choose Use VGA Hardware Palette if the test worked.
4. Choose OK. 
5. Exit Windows and restart CorelPHOTO-PAINT to make the VGA Hardware Palette 
option take effect.

Related Topics
Adjusting the On-screen Brightness of your Pictures
Optimize Display
Preferences



Selecting Memory Options

To setup virtual memory:
1.Select Enable Virtual Memory.
2. Type a number in the Min KB text box.
3. Type a number in the Max KB text box.
4. Specify the Virtual Memory Path.
5. Choose OK.

Related Topics
Preferences



Options Soft Brush Settings Command -- Adjusting Soft Brushes

To adjust soft brush settings:
1.Adjust the options you want.
2. Choose OK.

Related Topics
Airbrush
Clone
Paintbrush
Smear Paintbrush



Soft Brush Settings Dialog Box Options
Edge
Density
Transparency
Fade Out
Spacing
Rate Of Flow
Rubber Stamp

Related Topics
Airbrush
Clone
Paintbrush
Smear Paintbrush
Soft Brush Settings



Options Tile Pattern Command -- Opening a Tile Pattern

To open a tile pattern:
1.Select a File Type option.
2. Select the drive and directory you want.
3.  Click a file in the File Name list box.
4. Choose OK.

Related Topics
Previewing a Picture
Save As
Tile Pattern Paint Roller



The Window Menu

You use Window menu commands to rearrange CorelPHOTO-PAINT picture windows 
rearrange minimized pictures, duplicate a picture, and change the active picture
To choose a Window menu command, click Window and choose the command you want.
To change your active picture click the Window menu and choose a different picture from the
picture list. For more information see Activating a Picture Window.

Window Menu Commands
Cascade Layers CorelPHOTO-PAINT picture windows so each title bar is visible.
Tile ArrangesCorelPHOTO-PAINT picture windows in equal sizes to fit on your 

screen.
Arrange Icons Arranges minimized pictures across the bottom of the CorelPHOTO-PAINT 

desktop.
Duplicate Duplicates pictures so you can see changes at different magnifications while 

you edit a picture.



Window Cascade Command -- Cascading Your Picture Windows

To layer your picture windows:
· Choose Cascade from the Window menu.

Related Topics
Activating a Picture Window
Tiling Your Picture Windows



Window Tile Command -- Tiling Your Picture Windows

To arrange your picture windows:
· Choose Tile from the Window menu.

Related Topics
Activating a Picture Window
Cascading Your Picture Windows



Window Arrange Icons Command -- Arranging Your Picture Icons

To arrange picture icons:
· Choose Arrange Icons from the Window menu.



Activating a Picture Window

To activate a picture:
· Click the name of the picture on the Window menu picture list or click the title bar of the 

picture.



Window Duplicate Command -- Viewing a Picture in Multiple Views

To duplicate a picture:
· Choose Duplicate from the Window menu.

Related Topics
Locator
Zoom tool
Zooming In and Out with the Zoom Commands



The Control Menu

You use Control menu commands on the CorelPHOTO-PAINT program and picture windows to
move, close, restore, and change the size of the window. These commands are standard 
Windows commands. A picture window Control menu also has the Image Info command and 
the Image Resolution command.
You use Control menu commands on the CorelPHOTO-PAINT workboxes to move and hide the
workboxes. The Toolbox workbox Control menu also has the Layout command, and the 
Palette workbox Control menu also has the Fold/Unfold command.
Point to a topic below and click for more information about the Control menu commands 
unique to CorelPHOTO-PAINT.

Control Menu Commands
Image Info Displays information about the picture.
Image Resolution Changes the resolution of the picture.
Layout Allows you to change the width and height of the Toolbox and to group or 

ungroup the tools.
Fold/Unfold Allows you to fold or unfold the Palette workbox.



Image Info Command -- Displaying Picture Information 

To view information about a picture:
1.Read the information about your image.
2. Choose OK to return to your picture.

Related Topics
Image Resolution
System Info



Image Resolution Command -- Adjusting Image Resolution

To adjust the resolution of an image for printing:
1.Use the mini-scroll bars to adjust the resolution.
2. Choose OK to return to your picture.

Related Topics
Image Info
Print



Layout Command -- Laying Out the Toolbox

To change your Toolbox layout:
1.Click the Control menu box on the Toolbox.
2.Choose Layout Ungroup or Layout Group.
3. Choose a column or row command to lay out your Toolbox.

Related Topics
Finding and Selecting Tools
Showing or Hiding Workboxes



Fold/Unfold Command -- Folding and Unfolding the Palette

To fold or unfold your Palette:
1.Click the Control menu box of the Palette.
2.Choose Fold or Unfold.
· Unfold displays all the colors or settings available in your Palette.

· Fold displays only the color selection box.

Related Topics
Selecting Tool Colors
Selecting Tool Settings
Showing or Hiding Workboxes



Viewing Colors on Your Screen

CorelPHOTO-PAINT provides device independence so you can load and edit images that have
more colors than your monitor supports. CorelPHOTO-PAINT simulates colors not supported 
by your monitor and retains all the original details and colors in your picture.
· To adjust how bright your pictures appear on-screen, use the Monitor Gamma option. See 

Adjusting the On-screen Brightness of Your Pictures.
· To enhance how simulated colors appear on-screen, use Optimize Display.
· If your VGA driver supports fewer than 16 levels of gray, you may be able to use 

CorelPHOTO-PAINT's VGA Hardware Palette option to improve the on-screen appearance of
gray scale pictures. For more information see Viewing More Levels of Gray.

Related Topics
Working with Different Numbers of Colors



Working with Different Numbers of Colors

CorelPHOTO-PAINT supports 24 Bit Color, 256 Color, Gray Scale, and Black and White 
pictures. A picture with fewer than 256 colors or grays is automatically converted to 256 
Color when you open it. A 32 bit picture is automatically converted to 24 Bit Color when you 
open it.
You can create and edit pictures that contain more colors than your hardware supports 
without losing original detail. CorelPHOTO-PAINT simulates colors on-screen that your 
monitor doesn't support, giving you device independence.
Following is general information about working with pictures. For more specific color 
information, click one of the Related Topics.
· Use Convert To to convert a picture to another color format. If you plan to use the picture 

with a device or application that requires a specific format, you can convert the picture, 
edit it, and then convert it to the format you need.

· To optimize how CorelPHOTO-PAINT simulates colors on-screen, use Optimize Display.
· To adjust how bright your pictures appear on-screen, use the Preferences command and 

adjust your Monitor Gamma.
· Filters work best with 24 Bit Color and Gray Scale pictures. For more information, see 

Using Filters.
· Retouch tools work best with 24 Bit Color and Gray Scale pictures.
· Some commands and tools are available only with 24 Bit Color or Gray Scale pictures. 

Commands that are unavailable for the format you are using are dimmed and cannot be 
selected. When you try to use a tool that is unavailable for the format you are using, you 
receive an error message.

Related Topics
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Gray Scale Pictures



Working with Black and White Pictures

A black and white picture is made up of only black and white. Grays are made up of 
individual dots of black and white. This mode is useful if you want high contrast Black and 
White pictures.
You can create, open, save, and edit black and white pictures with CorelPHOTO-PAINT.
· If you convert a picture to Black and White, you can choose a conversion type. 
· If you want to colorize a Black and White picture or take advantage of more options and 

tools, you can convert the picture to another color format.
· Black and White requires the least amount of memory.
· The following painting tools are not available for Black and White pictures: Airbrush, Color 

Replacer, Eyedropper, and Paintbrush.
· The only available retouch tool is the Smudge Spraycan.
· The only available filter is Remove Spots.
· You can open black and white pictures in the following formats: BMP, GIF, MSP, PCX, and 

TIFF.
· You can save black and white pictures in the following formats: BMP, EPS, GIF, PCX, and 

TIFF.

Related Topics
Working with Different Numbers of Colors



Working with Gray Scale Pictures

A Gray Scale picture is made up of 256 solid grays. This mode is useful if you do not want to 
add color to your picture.
You can create, open, save, and edit Gray Scale pictures with CorelPHOTO-PAINT. Grays not 
supported by your monitor are simulated on-screen, and the original detail is retained in 
your picture.
· When you convert a Gray Scale picture to color, the picture remains gray, but you can add

colors.
· If you use a VGA driver that displays fewer than 16 levels of gray, you may be able to use 

CorelPHOTO-PAINT's VGA Hardware Palette option to increase the number of grays 
displayed on-screen.

· All filters and tools are available.
· You can open Gray Scale pictures in the following formats: BMP, GIF, PCX, TARGA, and TIFF.
· You can save Gray Scale pictures in the following formats: BMP, EPS, GIF, PCX, TARGA, and

TIFF.
· Gray Scale pictures require less memory than 24 Bit Color pictures.

Related Topics
Adjusting the On-screen Brightness of Your Pictures
Optimize Display
Working with Different Numbers of Colors



Working with 256 Color Pictures

A 256 Color picture is made up of 256 solid colors. This mode is useful if you are creating 
pictures to view on-screen or if you don't have enough memory for 24 Bit Color pictures. 
CorelPHOTO-PAINT automatically converts a picture with fewer than 256 colors to 256 Color 
when you open it.
You can create, open, save, and edit 256 Color pictures with CorelPHOTO-PAINT. Colors not 
supported by your monitor are simulated on-screen and the original detail is retained in your
picture.
· The color set in the palette of a 256 Color picture defines the colors available for your 

picture.
· You can use Palette commands to adjust a single color, range of colors, or all the colors in 

your palette. However, the picture will also change.
· The following tools are not available for 256 Color pictures: Paintbrush, Airbrush, Blend 

Paintbrush, Sharpen Paintbrush, and Smear Paintbrush.
· The Clone soft brush settings are not used with 256 Color pictures.
· The following filters are not available for 256 Color pictures: Add Noise, Blend, Diffuse, 

Edge Detect, Emboss, Motion Blur, and Sharpen.
· You can open 256 Color pictures in the following formats: BMP, GIF, PCX, TARGA, and TIFF.
· You can save 256 Color pictures in the following formats: BMP, EPS, GIF, PCX, TARGA, and 

TIFF.
· To take advantage of all the filters and tools, speed up the retouch tools' response time, 

and use other color options unavailable for 256 Color pictures, use Convert To to convert 
your picture to 24 Bit Color.

Related Topics
Adjusting the On-screen Brightness of Your Pictures
Optimize Display
Working with Different Numbers of Colors



Working with 24 Bit Color Pictures

A 24 Bit Color picture is made up of 16,777,216 colors, providing better detail and depth 
than other color modes. Retouch tools and filters also work best in 24 Bit Color mode. You 
can paste pictures without changing their colors.
You can create, open, save, and edit 24 Bit Color pictures with CorelPHOTO-PAINT. Colors not 
supported by your monitor are simulated on-screen, and the original detail is retained in 
your picture.
· The color set in the Palette of a 24 Bit Color picture displays 256 of the 16.7 million colors 

available.
· To change the colors displayed in the color set for easy access: double-click a color in the 

palette; use any of the Palette commands, or pick up a color from your picture with the 
Eyedropper.

· You can use the Optimize Display command to change the look of 24 Bit Color pictures on-
screen.

· All of the filters and tools are available with 24 Bit Color pictures.
· You can open 24 Bit Color pictures in the following formats: BMP, PCX, TARGA, and TIFF.
· You can save 24 Bit Color pictures in the following formats: BMP, EPS, PCX, TARGA, and 

TIFF.
· To use your picture with a device or application that does not support 24 Bit Color, use 

Convert To to convert the picture to the color mode you need.

Related Topics
Adjusting the On-screen Brightness of Your Pictures
Optimize Display
Working with Different Numbers of Colors



Retouching and Enhancing Pictures

Adding Texture to Your Picture
Adjusting Individual Colors
Adjusting Soft Brushes
Blending Freehand
Blending with the Blend Filter
Brightening Freehand
Brushing Freehand
Changing All the Colors in Your Picture
Changing Contrast Freehand
Changing the Direction of Your Gradient
Changing Your Highlights and Shadows
Cleaning Up an Image
Creating a Motion Effect in Your Picture
Creating a New Color
Creating a Range of Colors
Diffusing Your Picture
Embossing Your Picture
Enhancing Edges
Filling an Area with a Gradient
Filling an Area with a Tile Pattern
Fine-Tuning with the Color/Gray Map Filter
Loading Response Curve Settings
Pixelating Your Picture
Replacing One Area with Another Freehand
Saving Response Curve Settings
Selecting Tool Colors
Selecting Tool Settings
Setting Your Tool Width
Shading with the Airbrush
Sharpening Freehand
Sharpening with the Sharpen Filter
Smearing Colors Freehand
Smudging Freehand
Tinting Freehand
Using Filters

Related Topics
Editing a Picture
Glossary
Painting with CorelPHOTO-PAINT
CorelPHOTO-PAINT Tools



Editing a Picture

Adding Text to Your Picture
Adjusting Soft Brushes
Brushing Freehand
Changing Your Font
Copying to the Clipboard
Cutting to the Clipboard
Defining a Polygonal Area
Defining a Rectangular Area
Defining an Irregular Area
Defining Areas with Similar Colors
Deleting Portions of Your Picture
Editing Your Picture Full Screen
Erasing Parts of Your Picture
Flipping, Rotating and Resizing
For Beginners
Inverting Colors in Your Picture
Making a Mirror Image
Manipulating Defined Areas
Moving Areas of Your Picture into View
Opening an Existing Picture
Outlining Shapes in Your Picture
Pasting from Disk
Pasting from the Clipboard
Saving Portions of Your Picture to Disk
Selecting Fonts
Setting Your Tool Width
Shading with the Airbrush
Smearing Colors Freehand
Starting a New Picture
Turning Your Picture on Its Side
Turning Your Picture Upside Down
Undoing Changes to Your Picture
Undoing Some Changes
Using Filters
Viewing a Picture in Multiple Views
Viewing the Same Area in Multiple Windows
Zooming In and Out with the Zoom Commands
Zooming In and Out with the Zoom Tool
Zooming to Fit

Related Topics
Glossary
Painting with CorelPHOTO-PAINT



CorelPHOTO-PAINT Tools
Retouching and Enhancing Pictures
The Edit Menu



Printing

Adjusting Image Resolution
Printing a Picture
Selecting Preferences
Setting Up Your Printer

Related Topics
Glossary



Painting with CorelPHOTO-PAINT

Adjusting Soft Brushes
Brushing Freehand
Changing Your Brush Style
Changing Your Tool Width and Shape
Drawing a Filled Box
Drawing a Filled Ellipse/Circle
Drawing a Filled Polygon
Drawing a Filled Rounded Box
Drawing a Hollow Box
Drawing a Hollow Ellipse/Circle
Drawing a Hollow Polygon
Drawing a Hollow Rounded Box
Drawing Freehand Shapes
Drawing Single and Joined Curves
Drawing Single and Joined Lines
Erasing Parts of Your Picture
Filling an Area with a Gradient
Filling an Area with a Tile Pattern
Filling an Area with Color
Finding and Selecting Tools
Laying Out the Toolbox
Moving Areas of Your Picture into View
Opening a Tile Pattern
Picking Up a Color from the Screen
Replacing One Area with Another Freehand
Replacing One Color with Another
Selecting Tool Colors
Selecting Tool Settings
Setting Your Tool Width
Shading with the Airbrush
Smearing Colors Freehand
Smudging Freehand
Specifying Color Tolerance
Splattering Color with the Spraycan
Viewing the Same Area in Multiple Windows

Related Topics
Editing a Picture
Glossary
CorelPHOTO-PAINT Tools
Retouching and Enhancing Pictures



Working with Colors

Adjusting Individual Colors
Adjusting the On-screen Brightness of Your Pictures
Changing All the Colors in Your Picture
Changing Color Formats
Changing the Direction of Your Gradient
Clearing Your Picture to the Background Color
Creating a New Color
Creating a Range of Colors
Inverting Colors in Your Picture
Loading a Palette
Mixing RGB Colors
Optimizing Your Display
Picking Up a Color from the Screen
Replacing One Color with Another
Saving a Palette
Selecting Tool Colors
Selecting Tool Settings
Shading with the Airbrush
Smearing Colors Freehand
Specifying Color Tolerance
Tinting Freehand
Viewing Colors on Your Screen
Viewing More Levels of Gray
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Different Numbers of Colors
Working with Gray Scale Pictures

Related Topics
Glossary



Working with Files

Changing Color Formats
Closing a Picture
Displaying Picture Information
Loading a Palette
Loading Response Curve Settings
Opening a Tile Pattern
Opening an Existing Picture
Previewing a Picture
Saving a Palette
Saving a Picture with a New Name
Saving a Picture with Save
Saving Response Curve Settings
Selecting Preferences
Starting a New Picture
Working with 24 Bit Color Pictures
Working with 256 Color Pictures
Working with Black and White Pictures
Working with Gray Scale Pictures

Related Topics
Glossary
The File Menu
Working with Windows



Working with Windows

Activating a Picture Window
Arranging Your Picture Icons
Cascading Your Picture Windows
Closing a Picture
Displaying System Information
Editing Your Picture Full Screen
Exiting CorelPHOTO-PAINT
Folding and Unfolding the Palette
Laying Out the Toolbox
Opening an Existing Picture
Scrolling
Selecting Memory Options
Selecting Preferences
Showing or Hiding Workboxes
Tiling Your Picture Windows
Using CorelPHOTO-PAINT Shortcuts
Using CorelPHOTO-PAINT Windows
Viewing a Picture in Multiple Views
Viewing Only Your Picture
Viewing the Same Area in Multiple Windows
Viewing Your Picture with No Zoom

Related Topics
For Beginners
Glossary
The Window Menu



CCapture Utility

CorelPHOTO-PAINT has a screen capture utility you can use to capture areas of your screen.
CCapture: Takes over your Windows screen capture functions so you can capture all or part 
of your screen and keep your colors intact!
See the Reference section of your CorelPHOTO-PAINT User's Guide for more about CCapture.



· Choose Clipboard to load the contents of the Windows clipboard.
· To use a file from disk, follow the steps below.



· Click Info to preview and read information about the picture.



· Choose Yes to save changes.
· Choose No to cancel changes.
· Choose Cancel to continue working.



· The cutout is replaced by the background color.



· If you paste into a 256 Color or Gray Scale picture and the cutout contains colors not included in the 
palette, the cutout's colors change.

· The cutout's colors do not change if you first convert the picture to 24 Bit Color or load a more 
compatible palette.



· The cutout appears in the upper left corner of your picture, enclosed by the Gadget Box.



· You can manipulate a cutout until you paste it.



· Use Copy to store a defined area on the clipboard without cutting it from the picture.
· Use Cut to cut and store a defined area on the clipboard.
· Use Delete to delete a defined area and preserve the contents of the clipboard.



· Do not choose the .EPS format until you finish making changes to your picture.



· Select 16 Color/Gray Scale to save with 16 colors.
· If you open the picture again, Photo Finish converts the picture to 256 colors.
· Use File Save As to save the picture again in 16 Color/Gray Scale.



· You can use this filter or tool with Gray Scale and 24 Bit Color pictures.
· Use Convert To to change the color mode if this filter or tool is not available.



· You can use this filter or tool with Gray Scale, 256 Color, and 24 Bit Color pictures.
· Use Convert To to change the color mode if this filter or tool is not available.



· The higher the number, the greater the effect.



· Choose Screen Preview if it is available to see how changes may alter your picture.



· To display a workbox, choose a Workboxes Show command from the Display menu.
· To quickly display the Toolbox workbox, press Ctrl+T.
· To quickly display the Width & Shape workbox, press Ctrl+W.
· To quickly display the Palette workbox, press Ctrl+P.



· The area you click centers in the picture window.



· To see changes occur in other zoom views, duplicate the picture and adjust the zoom levels. Use the 
Locator tool to display the same area in all copies.



· Use the Locator tool to quickly display the same area in all windows that contain the same duplicates.



· Click the left mouse button to choose the primary color.
· Click the right mouse button to choose the secondary color.
· Hold down Shift and click the left mouse button to choose the background color.



· The Box Selection, Magic Wand, Lasso, and Scissors may be grouped in the Toolbox. Press the left 
mouse button on the triangle in the bottom right corner of the current tool. When the available tools 
appear, drag the mouse to the tool you want, and release the mouse button.



· You can manipulate the defined area.



· Use Undo to cancel all changes made since the last time you chose a tool or command.
· Use Local Undo to cancel only some changes made since the last time you chose a tool or command.



· The Paint Roller, Tile Pattern Paint Roller, and Gradient Paint Roller may be grouped in the Toolbox. 
Press the left mouse button on the triangle in the bottom right corner of the current tool. When the 
available tools appear, drag the mouse to the tool you want and release the mouse button.



· Completely enclose the area you are filling or the color "leaks out." If this happens, choose Undo and 
zoom in to fix any "holes" in the border.

· You may have to adjust color tolerance to control color leaking.



· The primary color is used for the border of hollow or filled shapes.
· The secondary color is used inside filled shapes.



· Click the shape button in the Width & Shape workbox to quickly change the shape.
· Type numbers or use the mini-scroll bar in the Width & Shape workbox to change the tool's size.



· The Line and Curve may be grouped in the Toolbox. Press the left mouse button on the triangle in the 
bottom right corner of the current tool. When the available tools appear, drag the mouse to the tool you 
want and release the mouse button.



· To draw joined curves or lines, draw your first curve or line. (Do not paste the curve.) Point to where you
want the second curve or line to end and click the right mouse button.

· To draw rays joined at a single point, draw the first curve or line. (Do not paste the curve.) Point to 
where you want the second curve or line to end, hold down Ctrl, and click the right mouse button.



· The Hollow Box, Hollow Rounded Box, Hollow Ellipse/Circle, and Hollow Polygon may be grouped in 
the Toolbox. Press the left mouse button on the triangle in the bottom right corner of the current tool. 
When the available tools appear, drag the mouse to the tool you want and release the mouse button.



· The Filled Box, Filled Rounded Box, Filled Ellipse/Circle, and Filled Polygon may be grouped in the 
Toolbox. Press the left mouse button on the triangle in the bottom right corner of the current tool. When 
the available tools appear, drag the mouse to the tool you want and release the mouse button.



· If you want a filled shape without a border, set the width to 0.



· Hold down Shift while you drag to constrain the tool to a circle.
· To draw concentric ellipses or circles, draw your first ellipse or circle. Then, press the right mouse 

button and drag to draw the others.



· Hold down Shift while you drag to constrain the tool vertically or horizontally.
· To change the level of the effect, select a different level from the Palette.
· Repeated brushes have no effect unless you save the changes. To save the changes, click the tool and 

brush again.



· The secondary color begins gradients.
· The background color ends gradients.
· To create a smoother gradient in 256 Color pictures, use Palette Range of Colors or load another 

palette and adjust your colors so they have the same hue.
· You can also convert your picture to 24 Bit Color to get smoother gradients.



· Use the Box Selection, Magic Wand, Lasso, or Scissors to define an area.



· The farther the number is from 0, the greater the effect.
· You can also click in the slider bars or drag the slider bar arrows to adjust the brightness and contrast.
· As a rule of thumb, increase contrast about one tenth the amount you increase brightness.



· The arrows point to the location of the light source and determine the angle of the highlights and 
shadows.



· The color you choose determines the overall color of your embossed image.
· For best results, choose a medium grayish color. 



· Default settings generally provide good results.
· Shades to the left of the Low arrow are black.
· Shades to the right of the High arrow are white.
· Highlights are the shades between the High and Mid values.
· Shadows are the shades between the Low and Mid values.
· Choose Restore to return to the original values.



· The larger the spot size, the more time is required for the filter to work.



· The converted picture is loaded into a window named NEW.
· Use Save As to save the converted picture.



· Colors are reversed as if on a photographic negative.



· Shapes are outlined, and everything else in the picture is the background color.



· Your picture is turned on its side. Use this to change orientation between portrait and landscape.



· You can create Gray Scale, 256 Color, 24 Bit Color, and Black and White pictures.



· Type numbers in the boxes or use the mini-scroll bars to set the size.
· The dialog box indicates how much memory is needed for the picture and how much remains.



· The picture's name appears on the picture's title bar and the Window menu and File menu picture lists.
· You can open up to 8 pictures at one time.



· Information includes the picture's name, the last time the picture was saved, height and width in pixels, 
number of colors, file size, image size, format, and type of compression used, if any.



· If you have selected Keep Thumbnail Files in Preferences, CorelPHOTO-PAINT displays the small 
picture more quickly the next time you preview the picture.



· Use Save As to save a picture for the first time or to save an existing picture with a new name or in a 
different format.

· Use Save to save changes in a previously saved picture.



· Before you print, use Printer Setup to set up your printer.



· 1 to 1 prints the picture at its current size. This option does not adjust for picture resolution.
· Actual Size prints the picture at its current size and resolution.
· Fit to Page resizes the picture to the page size indicated in your Printer Setup dialog box.
· Scale changes the printed size of the picture. Adjust the size in the Scale text box. Choose Poster to 

print across multiple pages if you scale a picture larger than your page. Choose Smooth (available for 
24-bit and grayscale images only) to remove blockiness that often occurs when you print a picture 
larger than its actual size.



· Use CorelPHOTO-PAINT's to let CorelPHOTO-PAINT select the best pattern.
· Use Printer's to use the printer's default halftone, if it has one.



· The options you can change depend on your printer.



· The duplicate picture appears in a new window at the same magnification as the previous window and 
is added to the Window menu picture list.



· The active window is placed at the top left corner of the desktop.



· Use the Layout command on the Toolbox Control menu to change the Toolbox layout and to group or 
ungroup tools.

· Use the Fold/Unfold command in the Palette Control menu to fold or unfold the Palette.



· You can edit your picture in Full Screen mode.
· You cannot edit your picture in Show Screen mode.



· Use Select to add up to four fonts to the Font menu list.



· Select values for Red, Green, and Blue.
· To fill, replace, or select a single color, set the values to 0.
· Choose Identical Values to set all the ranges at the same values.



· Choose Restore to return to the original values.



· Click the left mouse button on the color you want to start the range.
· Click the right mouse button on the color you want to end the range.



· VGA Palette isn't available if your screen displays 16 or more gray levels.
· Read the warning in the dialog box before you complete this command.



· Click to increase the number of grays you see on-screen.
· Before you test your hardware, save all of your work. Your system may not support this option.



· If color areas become gray, you can use the VGA Hardware Palette.
· If the screen turns black or your system locks up, you cannot use the VGA Hardware Palette.



· Exit Windows and start Windows again to use the new VGA setup.
· The VGA setup becomes a CorelPHOTO-PAINT program default.
· Unselect the option if you no longer want to use it.



· Changes what CorelPHOTO-PAINT displays when you start the program.
· Choose Nothing if you do not want to load a file or see the About box when you start CorelPHOTO-

PAINT.



· Shows context-sensitive information at the bottom of your screen.



· Saves thumbnail preview pictures to disk with a    .THB extension.



· Click to change Photo Finish's virtual memory manager settings.



· Choose a unit of measure for your work in the Units list box.



· If Backup is selected, CorelPHOTO-PAINT saves a backup copy of your picture. The backup file's name
is the same as the original's, except the last letter of the extension is a $.



· Double-click the Zoom tool to quickly return to 100% view.



· Hue selects the color.
· Amount adjusts the color's intensity.
· Choose Restore to cancel changes.



· Hold down Shift while you drag to constrain the tool vertically or horizontally.
· Press the spacebar to change the direction of the constraint.



· Hold down Shift while you drag to constrain the tool to a square.



· Hold down Shift while you drag to constrain the tool vertically, horizontally, or diagonally.



· The Smear Paintbrush and Smudge Spraycan may be grouped in the Toolbox. Press the left mouse 
button on the triangle in the bottom right corner of the current tool. When the available tools appear, 
drag the mouse to the tool you want and release the mouse button.

· You can use the Smear Paintbrush with Gray Scale and 24 Bit Color pictures.
· Use Convert To to change the color mode if the tool is not available.



· The Smear Paintbrush and Smudge Spraycan may be grouped in the Toolbox. Press the left mouse 
button on the triangle in the bottom right corner of the current tool. When the available tools appear, 
drag the mouse to the tool you want and release the mouse button.



· The Clone tool gives you more precise control than copying and pasting a picture.



· The point where you click defines the center of the picture you want to clone with.
· To change the source for your clone, point to another area and click the right mouse button.



· No cloning occurs after you reach the edges of your source picture.
· The first click with the clone brush sets the center point for painting.
· Hold down Shift while you drag to constrain cloning vertically or horizontally. Press the spacebar to 

change the direction of the constraint.



· Drag the square handles to reposition the ends of the curve.
· Drag a circle handle to bend a portion of the curve.



· You can enter more than 400 characters, or about 10 lines of text.
· Press Ctrl+Enter to start a new line.
· Press Shift+Ins to insert text from the clipboard.



· The text appears in your picture surrounded by the Text Frame box.
· Drag the handles on the Text Frame to adjust your margins.
· Drag the Text Frame to move your text to another location before you paste it.



· Press the spacebar to edit your text.
· Select a different color from the Palette if you want to change the color of your text.
· Use the Font menu to select another font or change font style, size, and effects.



· To make another picture active, click the title bar of the picture you want to edit or choose its name from
the Window menu picture list.



· Double-click an icon to restore the picture to your desktop or choose its name from the Window menu 
picture list.



· A checkmark appears beside the command to show it is selected.
· CorelPHOTO-PAINT applies the best halftone for the picture. Using this command slows down the 

program's response time.
· You can make other on-screen adjustments with the Monitor Gamma and VGA Palette options in the 

Preferences dialog box.



· Adjust soft brush settings for the tool.



· Select a new brush style.



· Replace the primary color with the secondary color in the area you see in the active picture window.



· Close the window or hide the workbox.



· Replace all colors in a picture with the background color.



· Adjust color tolerance.



· Quickly select the area you see in the active picture window.



· Set your tool width.



· Like Edit Undo, return your picture to the look it had before you last chose a tool or command.



· Adjust a single color in a 256 Color or 24 Bit Color picture.



· Quickly return to a one-to-one view in a zoomed picture.



· Hold down Shift while you drag to constrain the tool to a circle.



· Hold down Shift while defining an area with the Box Selection to define a square.
· Hold down Shift while defining an area with the Scissors to constrain horizontally, vertically, or 

diagonally.
· Hold down Shift while you drag a cutout to leave a single copy behind.
· Hold down Ctrl while you drag a cutout to leave a trail of copies behind.



Key to CorelPHOTO-PAINT Help
Press and hold down the mouse button on an underlined down arrow for additional 

information.
Click an arrow that points to the right to jump to more in-depth information.
Point to a word with a broken underline and hold down the left mouse button to read 

the word's definition.
Click words with a solid underline to jump to information about that topic.



· Information includes the name of the picture, width and height in pixels, resolution in dots per inch, 
picture type, image size, picture format, subformat, and whether the picture has changed since it was 
last saved.



· Changing the image resolution affects how CorelPHOTO-PAINT prints your picture in certain modes 
and can affect how circles and squares look when you draw.

· If Vertical and Horizontal resolution are different, circles and squares do not look perfect.



· Flat shows more pronounced changes than Bell Curve.



· Because all colors are made up of red, green, and blue, all colors are affected by your selection.
· All adjusts all the colors in the picture.
· Single is the only channel available for Gray Scale.



· The larger the numbers, the greater the effect.
· You can choose Identical Values to quickly set Width and Height at the same values.



· The higher the number, the more edges are enhanced.



· The arrows point to the direction for the movement.



· Choose Cancel to undo all the changes you have made and return to the main CorelPHOTO-PAINT 
screen.



· RGB adjusts the amount of red, green, and blue.
· CMY adjusts the amount of cyan, magenta, and yellow.
· HLS adjusts the hue, lightness, and saturation.



· Click in the Color Slider bar or drag the Color Slider arrow.
· You can also use the mini-scroll bar or type a number in the appropriate text box to the right of the 

slider.
· Choose Restore to return to the original values.



· The color you click on appears in the color sample box.
· You can also drag in the Color Refiner box to select a color.



· Adjusts the edges of the paint stroke. 
· Hard keeps the edges of the paint stroke hard. 
· Medium partially softens the edges of the paint stroke. 
· Soft softens the edges of the paint stroke the most. 



· Adjusts the overall softness of the paint stroke. 
· The lower the number, the finer the brush strokes with smaller, softer edges. 
· The higher the number, the bolder the brush strokes with less soft edges. 



· Adjusts the opacity of your paint.
· The higher the number, the greater the transparency.



· Adjusts the rate at which the brush stroke disappears. 
· The higher the number, the more fade out occurs.



· Adjusts the distance between each stroke as you drag the tool. 
· The lower the number, the closer the brush strokes. Use a setting of 1 for the smoothest stroke.
· This option is not available for the Airbrush tool.



· Adjusts how fast the paint is applied.
· The higher the number, the faster the paint is applied.
· This option is available for the Airbrush only.



· Paints multiple copies of your clone source.
· If Rubber Stamp is selected, your clone source is reset to the beginning each time you click the left 

mouse button.
· This option is available for the Clone tool only.



· Select this option to use CorelPHOTO-PAINT's virtual memory manager. Enable Virtual Memory is 
recommended for standard mode.

· Disabling CorelPHOTO-PAINT's virtual memory manager improves program performance if you have 
enough Windows memory for your pictures.



· Type a number to specify in kilobytes the minimum amount of Windows memory you want to allocate to 
CorelPHOTO-PAINT.

· This option is not available if you have disabled CorelPHOTO-PAINT's virtual memory manager.



· Type a number to specify in kilobytes the maximum amount of Windows memory you want to allocate to
CorelPHOTO-PAINT. If the number is too high, you may notice a decrease in program performance.

· This option is not available if you have disabled CorelPHOTO-PAINT's virtual memory manager. 



· Assigns up to four drives CorelPHOTO-PAINT uses to store temporary files.
· This option is unavailable if Enable Virtual Memory is not selected.
· List fastest drives first.
· Separate paths with a semicolon.
· Network and floppy drives are not recommended.



· Flips pictures or areas horizontally. The right side of your picture becomes the left side, like a mirror 
image.



· Flips pictures or areas vertically. The picture is turned upside down. 



· Rotates pictures or areas clockwise by 90, 180, or 270 degrees. 
· Deskew rotates pictures or areas by increments up to five degrees. To rotate your image clockwise, use

a positive number. To rotate your image counterclockwise, use a negative number.



· Increases or decreases the size of your picture.



· Keeps the same height and width ratio as the original picture when you resize.



· Changes a picture to Black and White.
· Choose Line Art if you do not want a halftone applied.
· Choose Printer to use a fatting halftone.
· Choose Screen to use a diffused halftone.
· Some commands and tools cannot be used with Black and White pictures.



· Changes a picture to 256 Color.
· Some commands and tools cannot be used with 256 Color pictures.



· Changes a picture to Gray Scale.
· Most commands and tools can be used with Gray Scale pictures.



· Changes a picture to 24 Bit Color.
· All commands and tools can be used with 24 Bit Color pictures.



· Click to change how bright pictures appear on-screen without changing the information in the picture.



· Select a drive from the Drives drop-down list.
· Select a Directory from the Directories list box.
· You can also type the full path and name in the File Name text box.



· The higher the number, the brighter your pictures appear.
· Change the gamma value and use Screen Preview until the picture appears to have 12 solid boxes. 

During adjustment, pay most attention to the center column.



· RGB adjusts levels of red, green, and blue in the selected color.
· HLS adjusts the hue and levels of lightness and saturation in the selected color.



· If you want CorelPHOTO-PAINT to automatically adjust the outline, choose Auto.
· If you are working with a Gray Scale picture, choose Light for white outlines or Dark for black outlines.
· If you are working with a 24 Bit Color picture, choose Light for light colored outlines or Dark for dark 

colored outlines. 



· All adjusts all the colors in the picture and is the only channel available for Gray Scale pictures.
· Choose a single color channel to create special effects or to adjust color balance in your image. 



· Smooths distribution and fine-tunes other Styles.
· Point to the handles on the curve in the sample box and drag to adjust the curve.



· Allows you to draw any shape you want in the sample box.
· Point to the curve and drag to draw the curve you want.



· Allows you to adjust brightness and contrast of a channel.
· Point to the handles on either end of the line in the sample box and drag to make adjustments.



· If you want to save the response curve settings so you can use them with other images, choose Filter 
Color/Gray Map again and click Save.

· Choose Screen Preview to see how changes may alter your picture.
· Choose Restore to return to the original values.



· To close a single copy of a picture, use the Close command on the picture's Control menu.



· The Eraser changes parts of your picture to the background color.



· Double-click the Color Replacer tool to replace the primary color with the secondary color in the area 
you see in your picture window.



· The available command is the opposite of your current Toolbox format.
· An ungrouped Toolbox shows all of your tools and is larger than a grouped Toolbox.
· A grouped Toolbox arranges similar tools together so your Toolbox is smaller.



· The number of columns or rows changes, and the Toolbox remains grouped or ungrouped.



· The available command is the opposite of your current Palette layout.



· If you are working with a 256 Color or Black and White picture, you can select the Rubber Stamp option
in the Soft Brushes dialog box, but adjusting other soft brush settings does not change the Clone tool's 
effect. 



· Standard US letter size, 8.50 x 11.00 inches.



· Standard US legal size, 8.50 x 14.00 inches.



· The size you type in the Horizontal Size and Vertical Size text boxes.



· Standard US size, 11.00 x 17.00 inches.



· Standard European size, 29.70 x 42.00 centimeters.



· Standard European size, 21.00 x 29.70 centimeters.



· Standard European size, 14.80 x 21.00 centimeters.



· Standard European size, 17.60 x 24.00 centimeters.



· The command changes to Hide.



· The command changes to Show.



· CorelPHOTO-PAINT supports installed Windows fonts.



· If you don't have the Windows font style or point size you want, you can use a font program to create 
them.



· When the Select a Brush Style dialog box appears, select a shape and click OK.



· Choose Cancel to return to the work area.



· Box Selection, Magic Wand, Lasso, Scissors



· Line, Curve



· Paint Roller, Gradient Paint Roller, Tile Pattern Paint Roller



· Hollow Box, Hollow Rounded Box, Hollow Ellipse/Circle, Hollow Polygon



· Filled Box, Filled Rounded Box, Filled Circle/Ellipse, Filled Polygon



· Smear Paintbrush, Smudge Spraycan



· You can use this command with all paintbrush tools and the Airbrush, Clone, Color Replacer, Curve, 
Eraser, Fountain Pen, Line, and Local Undo tools.



· The farther the number is from 0, the greater the effect.



· You can use this command with 256 Color and 24 Bit Color pictures.

· Use Convert To to change the color mode if this command is not available.



· GAMMA.PCX is included with CorelPHOTO-PAINT to help you adjust on-screen brightness.



· The settings you adjust affect only the selected tool so you can alternate between soft tools without 
having to change settings.




